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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Before you start

The Getting Started Exercises provide a quick way to learn the
Cerity Pharmaceutical QA/QC application. Use the Cerity
Concepts Guide to help you do the tasks in these exercises.

Setting Up Methods

If you develop methods for your laboratory, you should go
through these exercises. You can use these methods to run
samples and sequences with the Running Routine Samples
exercises.

Running Routine Samples

If you run samples but do not develop methods, you can do
these exercises with the default methods that come with the
Cerity Networked Data System, or you can use the methods set
up with the Setting Up Methods exercises.

Before you start

Make sure that you or your administrator transfer the default
methods and example chromatogram from the Cerity CD-ROM
to the database. For details to transfer the methods and make
them usable for your system, turn to the next page.
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Before you start

Step 1. Restore the default methods

The default methods for the Basic and Advanced exercises are
located on Cerity software CD in \GettingStarted\DefaultMethods.

1

S O A W

~

Restore the default methods.

The default methods for the Basic and Advanced exercises
are located on Cerity software CD in \GettingStarted\
DefaultMethods.

Select Start > Programs > Agilent Cerity > Administration and
Maintenance > Archive and Restore.

Enter logon information and click 0OK.
Select Restore, and click Next.
Click the ... button.

Select \GettingStarted\DefaultMethods\Basic (or \Advanced) on
the CD-Drive.

Click OK, click Next, and click Yes to the messages.

8 Click the >> button to move the default methods to the

Restore Objects list.

Click Next, click Start, and click OK for each message that
appears.

The following message appears: “These tables contain
duplicates”.

Step 2. Resolve database duplicates

e o1 A W

Click Next.

Make sure that the Select instruments to enable check box is
clear.

Click Next and select the second Administrator role.

Click Rename, enter the new role name Admin and click 0K.
Click Next, click Start, and click OK.

Click OK and any Close buttons.

Cerity NDS Getting Started Guide



Before you start

Step 3. Restore the example chromatogram

The example chromatogram is on Cerity-CD-1in \GettingStarted\
DefaultResults. Make sure that the default example
chromatogram has been restored.

1 Repeat step 1 through step 4 in “Step 1. Restore the default
methods” on page 6.

2 Select \GettingStarted\DefaultResults on the CD-ROM drive,
click OK, and click Next.

Select defexchrom2a, click >, and click Next.

4 Click Start, click OK to the messages that appear, and click
Close.

5 Select Start > Programs > Agilent Cerity > Cerity Pharmaceutical
QA’/QcC.

6 Enter logon information and click OK.
7 Select Result from the Current View list.
8 Select AllResultsRestored from the Query list.

Cerity NDS Getting Started Guide 7



Before you start

Step 4. Copy the default method to use with your instrument

The first time that you copy and
rename Advdefaultmethod4, name
it defexerda. The first user will
alter this method in Exercise 4b.
You must then copy
Avdefaultmethod4 and rename it
defexerdb for the second user to
use the method.

Refer to “Basic Exercise #2 Set up a method for single samples
to identify compounds” on page 81 if you need to.

1 Select Method from the Current View list.
2 Select AllMethodsRestored from the Query list.
3 For each default method:

a
b

N o o

Select File > New > Method.

Click Browse, select defaultmethodN for Basic exercises, or
AdvdefaultmethodN for Advanced exercises, and click OK.

Name the new method defexerN, and click Next.

Select the instrument where the method will be used, and
click Next.

Click Next until you reach the New Method Review panel.

Click Finish, and click Save when the Save to the database
message appears.

Select AllMasterMethods from the Query list.
Expand defexerN.
Expand Instrument Setup, and adapt the settings.

Adapt the instrument settings for the non-matching LC

modules.

You can use the default methods ONLY on instruments with an
Agilent VWD detector. Your other LC modules do NOT have to
match the modules on which the default methods were set up
(autosampler, quaternary pump, thermostatted column
compartment).

If you have no instrument available with a VWD detector to use
with these exercises, then the administrator or advanced user
should set up the methods using the Setting Up Methods
sections in this guide.
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‘0 e » - Running Routine Samples
[

These exercises help you learn how to run routine samples. You
can use the default methods for the “a” exercises or set up
methods in the Setting Up Methods exercises. You must have
results from the “a” exercises to do the “b” exercises. The set of

basic and advanced exercises includes the topics below:

Exercise 1 — Equilibrate the instrument Learn how to equilibrate
the instrument with the instrument panel or with a method.

Exercise 2a — Run a single sample to produce an example
chromatogram Learn how to produce an example
chromatogram that you can use to set up integration and
identification in a method.

Exercise 2b — Run a group of single samples to identify compounds
Learn how to enter and run a group of single samples with a
method to identify the compounds in the sample.

Exercise 3a — Run a sequence to quantify compounds with
single-level calibration Learn how to run a sequence with
single-level, single-update calibration, ESTD quantitation, and
fixed amounts.

Exercise 3b — Reintegrate and reprocess the results Learn how to
manually reintegrate the sequence results, and reprocess the
results with the original method revision. For more information
on running routine samples, see the Concepts Guide, “Sample
Analysis”.

‘<. Agilent Technologies




Running Routine Samples

10

Advanced

Before you start

Exercise 4a— Run a sequence to quantify compounds with multi-level
calibration Learn how to run a sequence set up for multi-level,
overall calibration, variable compound amounts and sample
variables.

Exercise 4b — Change sample variables in the method and
reprocess Learn how to reprocess the results with the most
current version of the method and a version with new sample
variables.

Exercise ba — Run a sequence to quantify impurities Learn how to
create and run a sequence set up for ISTD quantitation, custom
calculations, limits, bracketed calibration and system
suitability.

Exercise bb — Use a different method to reprocess Learn how to
reprocess with a new method.

Read “Before you start” on page 5.

If you plan to use default methods in these exercises, make sure
that these methods are in your database. From the Query list,
select AllMethodsRestored to view defexerl-5 or
AllResultsRestored to view defexchrom?2a.

Your system administrator must have configured an Agilent
1100 LC series liquid chromatograph for your system.

If you choose to do the Running Routine Samples exercises with
the default methods, you must use an instrument with a VWD
detector. If you use the methods created in the Setting Up
Methods exercises, you need only an autosampler, pump
(quaternary or binary) and UV-Vis detector (VWD, MWD, DAD).

Solvent A is water. Solvent B is methanol or acetonitrile.

Use Agilent Technologies column Eclipse XDB-C8 (or C-18),
4.6MM X 15 CM (buM).

Prepare the following three vials of the isocratic standard,
Agilent Part # 01080-68704: undiluted, diluted by factor 2, and
diluted by factor 4.

Cerity NDS Getting Started Guide



Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Basic Exercise #1
Equilibrate the instrument

This exercise contains a series of tasks to help you learn how to:

* Equilibrate the instrument with the instrument panel in the
Cerity Pharmaceutical QA/QC application

¢ Enter and run an equilibration sample (blank run) with a
method created to equilibrate the instrument

You can use a copy of the default method that comes with the
system to equilibrate the instrument, or you can use the
method created in the “Basic Exercise #1 Set up an
equilibration method” on page 73.

For the tasks on the following pages, try the steps on the left
without the detailed instructions. If you need more help, follow
the detailed instructions on the right.

Before you start

Make sure that the pump is on standby and the VWD lamp is off.

Make sure that the methods for this exercise have been set up or
restored.

g Agilent Technologies 11




Basic Exercise #1 Equilibrate the instrument

Task 1. Purge the pump from the Instrument Panel

Steps Detailed Instructions

1 Disengage pump and purge line B. a Turn the black valve on the pump counterclockwise two full turns.

Flow rate: 5bml/min b

%B =100%

Select Instrument from the Current View list.

¢ Select the instrument that you intend to equilibrate.
The Instrument Panel appears, along with the Online Plot.

Instiument Panel | Worklist I

I TR BT
I —~% A B -2 A 2306°C

TR == ) o=0 = m
ll - bar A B &
P [ =%c o=z g [ 223°C

Mot in operation

<

|»]

On

EMELC2

3

d Click the pump module on the Instrument Panel.

v

A menu appears.

On
[t
Standby

Configuratiar...
Set Pump...

e Select Set Pump.

2 Purge line A and engage pump. a
%A =100 b

Enter a Flow of 5ml/min and %B=100, and click OK.

When there are no more bubbles in the line, repeat steps d and e from step 1.

Set %B =0, and click OK.

When there are no more bubbles in the line, click the pump module, and

select Standby.
Tighten the black valve.

12
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Task 2. Equilibrate the instrument from the Instrument Panel

Basic Exercise #1 Equilibrate the instrument

Steps

Detailed Instructions

1 Enter the pump parameters
Methanol as Solvent B:

Flow rate: 2ml/min.
Solvent composition:
80%MeO0H/20%H,0

Acetonitrile as Solvent B:

Flow rate: 1.5ml/min
Solvent composition:
65%ACN/35%H,0

2 Turn the detector lamp on

a Click the pump module on the Instrument Panel.
b Select Set Pump.

The Set Pump dialog box appears.

¢ Enter the pump parameters as shown in the left column, and click OK.

Elows
Flow: |2 _I; mldmin
—Solvent aet, Fill [literst— —bax. Fill [liters}—
& 20 z || oo = EE=
5 | o, = =
B s = oz || |os EE=
. O P = [ =
D: [ O fo = 5 =
Gose | |t

d Click the pump module, and select On.

a Click the detector module on the Instrument Panel.

b Select Lamp On.

Wait until baseline has stabilized.

Cerity NDS Getting Started Guide
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Basic Exercise #1 Equilibrate the instrument

Steps Detailed Instructions

3

Monitor the baseline until it appears a Click Change at the bottom of the Online Plot.

stable. The Edit Signal Plot dialog box appears.

After this step, you are ready to do the |,
remaining exercises, or you can move
on to the next task to learn to
equilibrate the instrument with a

Select the detector signal you need from the Available Signals list, and click
the Add button to put the signal in the Selected Signals list. (You can also
select the pump pressure).

¢ Set the Predictable Range (Y-axis) as -10 to +10.

method. Set the X-Axis range as 10 min.
e Click OK.
dit Signal Plot M= B3
Awailable Signals Selected Signals
Huaternary Pump: Pressure la bzorbance

Quaternary Pump: Flow S = |

Quaternary Pump: %4
Quaternary Pump: %B b

Cuaternary Pump: %C

Quaternary Pump: %0 LI
—%WwD: Absorbance
' Predictable Range " Eloating Rangs
From: |-1U i' L e Enge; I i' il
To |1 i) i' mal [Hfzet: I i' s
= | St yradiust

—window Properties

H-awis range; |1 1] i' mir

™ Draw Grid

QK I Cancel | Aol |

f Click the detector module after the lamp has been on for a few minutes.
g Select Balance.
When the baseline stays at zero for a few minutes after the balance, the
baseline is considered stable.

14
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Basic Exercise #1 Equilibrate the instrument

Task 3. Equilibrate the instrument with a method—Enter an equilibration

sample

Steps

Detailed Instructions

1 Enter the sample information

Sample Name: equilsampiii, where jii

are your initials

Method: defexer1 or equilmethiii

See “Before you start” on page 5 for
instructions on how to restore and

copy the default methods.

2 Enter the tasks that the system will

do during the analysis.

3 Save the sample to the database

a Select Instrument from the Current View list.

b Expand the Sample Entry folder for the instrument that you need to
equilibrate.

¢ Select Single Samples.

d Enter the Sample Name as equilsampiii.

e Select the Method as equilmethiii or defexer1.

f Select the Sample Type as Blank Run.

g Click Apply.
You can also enter the sample in the Sample View when you need to enter
samples and sequences during a run.

a Clear the Quantify and Report check boxes.
b Click Apply.

INSTRUMENT NAME METHOD NAME SAMPLE NAME NUM OF INJECTIONS

Sample Entry | Sample Logbook

Sample Name: Run |Amounts|\dent\lication Description | Report Destination

quui\sampdac
Method:

equilmethdec - I |

Sample Type:

ISampIe j
Instrument

JEMELC3 =l
Wial Mumber Injections Wolumne [u]

IT 1 Ias method

D20 T 9

Click the Save button.

rRunwith—————————————————
Priority: Schedule:

W Unknowin
rTaskls|to pefform————————————————
| Eequie I™ Quantify
I [ earet= I” Feport

On the Standard toolbar, click [&].
Review the list of changes

Under Reason for changes, enter a reason or select a reason from the list.
Enter your electronic signature if required.

Cerity NDS Getting Started Guide




Basic Exercise #1 Equilibrate the instrument

Task 4. Equilibrate the instrument with a method—Run the equilibration

sample
Steps Detailed Instructions
1 Run equilsampiii a Select the sample, equilsampiii, in the Sample Table.
The Run button is now active.
b Click the Run button :_-k on the Actions toolbar.
2 Monitor the baseline until it is a Select the instrument that you want to equilibrate.
stable. The Instrument Panel appears, along with the Online Plot.

b Click Change at the bottom of the Online Plot.
The Edit Signal Plot dialog box appears. (See the figure on page 14.)

¢ Select the detector signal you need from the Available Signals list, and click
the Add button to put the signal in the Selected Signals list.

d Set the Predictable Range as -10 to +10.

e Set the X-Axis range as 10 min.

f Click OK.

Online Flol | Lagbook |

WND: Absorbance

T T T T T
3080 3082 2084 3088 min

::l Change. Adiust | LH
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Basic Exercise #2a
Run a single sample to produce an
example chromatogram

This exercise contains a series of tasks to learn how to:

* Enter a sample to produce an example chromatogram

* Run the sample

* Review the results

An example chromatogram can be any chromatogram that you
produce. Use the example chromatogram to test new integration
parameters and identify peaks as compounds.

You can use one of the following methods for this exercise:

* A copy of the default method provided with the Cerity
Networked Data System.

* The method saved in “Task 3. Save and audit method
changes” on page 86 in the Setting Up Methods section.

* An equilibration method that you created in “Basic Exercise
#1 Set up an equilibration method” on page 73.

For the tasks on the next pages, try the steps on the left without
the detailed instructions. If you need more help, follow the
detailed instructions on the right.

Before you start

Read “Running Routine Samples” on page 9 for running routing
samples.

Equilibrate the instrument. See “Basic Exercise #1 Equilibrate
the instrument” on page 11. Make sure that the methods for this
exercise have been set up or restored.

g Agilent Technologies 17




Basic Exercise #2a Run a single sample to produce an example chromatogram

Task 1. Enter a single sample

Steps

Detailed Instructions

1 Start the Instrument View to find the
sample table for single samples.

2 Enter a sample with the following
information:

Name the sample exchromiii,
where Jii are your initials.
Select either defexer2, exer2iii
(when first saved), equilmethiii
Select the vial that contains the
full-strength isocratic standard.

3 Enter the tasks to perform during the
run.

4 Save the sample.

a Select Instrument from the Current View list.

b Expand the folder for the instrument that will produce the example
chromatogram.

¢ Select Single Samples.

The sample table and sample entry panel appear in the workspace.
a Enter exchromiii in the Sample Name box.
b Select a method from the Method list.
The instrument associated with the method appears in the Instrument box.

¢ Select Sample from the Sample Type list.

d Enter the vial number for the sample in the Vial Number box.
e Click Apply to put the sample information in the sample table.
Use the default values for all other parameters

a Clear the Quantify and Report check boxes.

Sample Entry | Sample Logbook I

Sample Name: FRun |Amounts| |dentification Descliplioml Report Destination

|exa|2bdec1

Vifd i~ Fiun with
i
leozdﬁ Priarity: Schedule;
exeiZdec -
'_I Mediumn ‘I Unknavin
Sample Type:
ii:DE IPDE J rTask(s]to perform—————————————
ample =
= | Zcquie ¥ Quantify
Instrument: —
¥ [rtegrate ™ Report
[EMELCE = s
Wial Mumber  Injections Wolume [pl]
|1 IW Ias method

a 0On the Standard toolbar, click E .

The Save Changes To The Database dialog box appears.

Review the List of changes.

Under Reason for changes, enter a reason or select a reason from the list.

Enter your electronic signature if required.
Click the Save button.

o220 T
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Basic Exercise #2a Run a single sample to produce an example chromatogram

Task 2. Run the sample

Steps Detailed Instructions

1 Check that the instrument is ready a Onthe selection tree, select your instrument.
for use. b Click the Online Plot tab.
Click the Change button.

The Edit Signal Plot dialog box appears.
Select the detector signal you need from the Available Signals list.
Click the Add button to put the signal in the Selected Signals list.

f Select the Predictable Range option and set the predictable range from
-20mAU to 300mAU.

g Under Window Properties, enter 5 min in the X-Axis range box.
h Click the OK button.
Edit Signal Plot M= =3

Awailable Signals Selected Signals
Fluaternary Pump: Pressure

Quaternary Pump: Flow S = |

Quaternary Pump: %4
Quaternary Pump: %B b

Cuaternary Pump: %C

Quaternary Pump: %0

5

W'D Abzorbance

—%WwD: Absorbance

& Predictable Rangs  Floating Range

From: |-2U i' L e Enge; I i' il

To |3UU i' mal [Hfzet: I i' s
= | St yradiust

—window Properties

H-awis range; |1 5 i' mir

™ Draw Grid

QK I Cancel Aol
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Basic Exercise #2a Run a single sample to produce an example chromatogram

Steps

Detailed Instructions

2 Run the sample.

3 Monitor the signal, and track the
status of the sample.

a Onthe selection tree, expand your instrument folder.
b Select Single Samples.
¢ Select the sample, exchromiii.

The Run button :_.j: becomes available on the Tools toolbar.

J* ° 1 = 3 y 'Q l§| |J Instrume:
EJIAIIInstruments =l B | NAME | METHOD [INSTRUMENT|

= @ Allnstuments equilzampeme  equilmetheme [Older version] ee-lc3 E
E E‘a eelcd 2 |s=exchromeme szexchromeme ge-Ic3 =
Et MR Single Samples :

d Click the Run button.

You can also run the sample from the Sample View.

a On the selection tree, select your instrument.
b Click the Online Plot tab to view the signal.

Change the axes if necessary.

Driline Plat | Logback |

WD Absorbance

mall -
200
150°
e
50 A
v T _I_ T T T

=1 o min

il Change... | Sdjst | lld

¢ Click the Worklist tab to track the status of the sample.

&)

TE Agilent Cerity NDS for Pharmaceutical QA/QC - AGILENTAMuskService - Administrator - Cerity for Phaima QA-QC

File Edit Wiew Go Tools pActions Help

[#@n=%gitu [rswmet ~ 0 - | &
|o B2 Z =3, % t ¥ & # Filbon |

IAIHnstluments j = B Instrument Panel WWHISll
= @Alllnsnuments [Sample Mame | Status |Sample Type| Method |[Pri
Et % Zl\;d.; 1 |Ssexchrumem52 Completed Sample metsscpodseme 00

After you click the Worklist tab, the Abort, Pause and Resume buttons
become available.

20
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Basic Exercise #2a Run a single sample to produce an example chromatogram

Task 3. Review the chromatogram

Steps Detailed Instructions

Select Result from the Current View list.
Select MySamplesRunLast24h from the Query list.

1 Review the sample result and make a
b
¢ Expand the Samples folder.
d
e
f

sure all four peaks are integrated.

Expand the exchromiii folder.
Select the exchromiii #1 injection.
View the chromatogram and results.

Signal

MO Abarh ancs

1889
3.000

z El in
Aesults
AT Compound Name Amount RF (Rsp/Amt) Peak Arca Peak Height P
ks 75 T [ITSE] 1275
0.7 N EEN 0.7701 0.3293
& B /2, 4136985 153.4284
1 Py 5, 3745102 1267572
o B 72, Z.6038 0.7451
7 Py 8, 0.2067 0.0663
EE] A |5, 3657.0248 98.3153
03 Py 22, 5236807 90,8962

Cerity NDS Getting Started Guide
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Basic Exercise #2a Run a single sample to produce an example chromatogram
Task 3. Review the chromatogram

22 Cerity NDS Getting Started Guide



Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Basic Exercise #2b
Run a group of single samples to
identify compounds

This exercise contains a series of tasks to learn how to:
¢ Enter a sample
* Run and track groups of single samples

¢ Review the results to check compound identification

You can use one of the following methods for this exercise:

* A copy of the default method provided with the Cerity
Networked Data System (NDS).

¢ The method completed in “Basic Exercise #2 Set up a method
for single samples to identify compounds” on page 81.

For the tasks on the following pages, try the steps on the left
without the detailed instructions. If you need more help, follow
the detailed instructions on the right.

Before you start

Read “Running Routine Samples” on page 9.

Equilibrate the instrument. See “Basic Exercise #1 Equilibrate
the instrument” on page 11.

Make sure that the methods for this exercise have been set up or
restored.

; Agilent Technologies 23



Basic Exercise #2b Run a group of single samples to identify compounds

Task 1. Enter three single samples

Steps Detailed Instructions

1 Start the Instrument View and find a Select Instrument from the Current View list.
the sample table for single samples. b Expand your instrument folder
¢ Select Single Samples.

The sample table and Sample Entry tab sheet appear in the workspace.

2 Enter a sample with the following a Enter exer2biii1 in the Sample Name box.

information: b Select the exer2 method from the Method list (or copy of defexer2b).
Name the sample exer2biii1, where
jii are your initials.
Select the method for the sample:
defexer2 or exer2iii
Select the Vial # that contains the
the full-strength isocratic standard.

The instrument associated with the method appears in Instrument box.

¢ Select Sample from the Sample Type list.
Enter the Vial Number that contains the standard.
e Click Apply to put the sample information into the sample table.

Sample Entry | Sample Logbook I
Sample Mame:

Run |Am0unts| Identificationl Descriptionl Fiepart Destination
Iexer2bdec1

N —Fiun with
thod:
Ie D2d J Pricrity: Schedule:
exerddec A
_l IMedium 'l Unknawn
Sample Type:
ia;np c I HhE J rTask[s) to perfform——————————————
ample A
¥ | Zcauire ¥ Quantify
Insts t:
nemen ¥ | [htemrate
[EMELE3 =l
Wial Mumber  Injections Wolume: [pl]
|1 1 Ias method

3 Enter the tasks that you want the a Mark the Quantify check box, and clear the Report check box.

system to do during the run You must mark the Quantify check box to identify the compounds, even
though Calibration and Quantitation are not set up in the method.
b Click Apply.
4 Save the sample a On the Standard toolbar, click [5g] .

The Save Changes To The Database dialog box appears.

b Review the List of changes.
¢ Under Reason for changes, enter a reason or select a reason from the list.
d Click the Save button.
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Basic Exercise #2b Run a group of single samples to identify compounds
Task 1. Enter three single samples

Steps Detailed Instructions

5 Repeat Steps 2 through 4 for the next a Select the empty row.

two samples. b Start with Step 2a and finish with Step 4d for exer2biii2.
Name these samples, exer2biii2 and ~ © Repeat steps a and b for exer2biii3.
exer2biii3. L

exerzdec
exerdec

enerlbdecd

ozt
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Basic Exercise #2b Run a group of single samples to identify compounds

Task 2. Run the samples

Steps Detailed Instructions

1 Check that the instrument is ready. a Select Instrument from the Current View list.
b Click the Online Plot tab.
Click the Change button.

The Edit Signal Plot dialog box appears.

d Select the detector signal you need from the Available Signals list.
Click the Add button to put the signal in the Selected Signals list.

f Select the Predictable Range option and set the range from -20mAU to
300mAU.

g Under Window Properties, enter 15 min in the X-Axis range box.

h Click the OK button.

Edit Signal Plot M= B3
Awailable Signals Selected Signals
Fluaternary Pump: Pressure b

Quaternary Pump: Flow S = |

Quaternary Pump: %4
Quaternary Pump: %B b

Cuaternary Pump: %C

Absorbance

Quaternary Pump: %0 LI
—%WwD: Absorbance
' Predictable Range " Eloating Rangs
From: |-2U i' L e Enge; I i' il
To |3UU i' mal [Hfzet: I i' s
= | St yradiust

—window Properties

H-awis range; |1 5 i' mir

™ Draw Grid

QK I Cancel Aol
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Basic Exercise #2b Run a group of single samples to identify compounds

Steps Detailed Instructions

2 Run the samples. Expand your instrument folder.
Select Single Samples.
Select the sample, exer2biiil.
Click the Run button | .
Select the sample, exer2biii2.
Click the Run button.

Select the sample, exer2hiii3.

Click the Run button.

The samples run in the order started, unless exer2biii3 is of a higher priority
than exer2biii2. Then, exer2biii3 runs before exer2biii2. The first sample
started will always run first even if the sample is a lower priority than the
other samples.

Qe 0o a0 - o

3 Monitor the signal, and track the a Click the Online Plot tab to view the signal.
status of the samples. Change the axes if necessary.

b Click the Worklist tab, and track the status of the three samples
1

Instrument Panel
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Basic Exercise #2b Run a group of single samples to identify compounds

Task 3. Review the chromatogram

Steps Detailed Instructions

1 Review the sample results and make Select Result from the Current View list.

sure all the compounds are b Expand the Calibration - exer2iii folder or defexer2 folder.
identified in each sample.

Calibration folder.

Expand the Samples folder.

Expand the exer2biii1 folder.

Select the exer2biii1 #1 injection.

View the result.

Repeat steps d through f for the following samples:
exer2biii2
exer2biii3.

e =0 a0

Even though calibration was not set up in the method, the result appears in a

IE Agilent Cerity NDS for Pharmaceutical QA/QC - SCHEIDERER ROBIN - Administrator - Cerity for Pharma GA-QC

File Edit View Tocls Actions Help

(| Reaut ~O- &S]k QA& = M| E Lo v % S v | [/ Honualinegaion = It @ | 8 < 2|

”'f1 S BRIt lmﬂmngnwnv‘

o IAHSampIEsNDmppvnvEdHUnL @ & e T e
N T s

VUND: Absarbance ( Example Chromatogram)

£ Blanks
K2 |5 ] samples 2
= | = Calbralion - exeradec Calb Rev 2 52 i A
| 3424 Samples = T T T T
=Y & exeicbdec3 [Rev ] 1 z 3 + min
2 £ eveizbdec? [Revi]
~ & Signal
i) VIV Abserb ance
El k3 =
i H §
8 i i
¥ g
o &
T T T
2 3 4 min
Results
RT Compound Name Amount RF (Rsp/Aml) Peak Arca Peak Height
[IEE] 5 5 EEEIH e300
110 A A 377.3964 1265203
1.8 biphenyl A A 3BB5180 93.0923
308 cterpheryl A A 5263579 912361
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Basic Exercise #3a
Run a sequence to quantify compounds
with single-level calibration

This exercise contains a series of tasks to help you learn to:

e Create a sequence with a method set up for single-level,
single-update calibration, ESTD quantification and fixed
compound amounts

e Select report types and set up a directory for reports
¢ Run and track the sequence

¢ Review the results to make sure the compounds have been
identified and quantified correctly

* Review the reports

You can choose between two methods to use with this exercise:
¢ a copy of the default method provided with the system.

* method that you created in “Basic Exercise #3 Set up a
single-level calibrated method for a sequence” on page 91.

For the Basic exercises, try the steps on the left without the
detailed instructions. If you need more help, follow the detailed
instructions on the right.

Before You Start

Read “Running Routine Samples” on page 9.

Equilibrate the instrument. See “Basic Exercise #1 Equilibrate
the instrument” on page 11.

Place all the vials of prepared samples into the ALS tray. Make
sure that the methods for the exercise have been set up or
restored.
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration

Task 1. Create a new sequence

Steps

Detailed Instructions

Create a new sequence.

Name the sequence exer3seqjii,

where jii are your initials.

Use one of the two methods:
defexer3

exerdjii (created with Exercise 3 of
Setting Up Methods)

a Click the New button, D , in the Standard toolbar, and select Sequence.
The Create New Sequence dialog box appears.

Enter the Sequence Name as exer3seqjii.

Select the Instrument that will run the sequence.
Select the Method for the sequence.

Click OK.

O 220 T

reate Hew Sequence EHE

Sequence Mame: IexerSSeqeme

Instrument,  [GetStatlC Browse... |

Method: IexerSsingIeveI

0K | Cancel

f If the Save Changes to the Database dialog box appears, select the Reason
for changes, if present, and click Save.
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration

Task 2. Enter sample and sequence information

Steps

Detailed Instructions

1 Review the Sequence Table

Note how the sequence table
matches the sequence template setup
in the method.

2 Enter the tasks to be performed
during the run:

Quantify, Report.

Acquire and Integrate are always
marked.

a Select Instrument from the Current View list.
b Expand the instrument you are using, and select the sequence you just

created.
¢ Review the table.

Sequence Dptions I

a Click the Sequence 0

2 |zample1_2 Sample

3 |zample1_4 Sample

4 |Cal Calibration 1
5 |zample1_2 Sample

6 |zample1_4 Sample

¥ |Cal Calibration 1
8 |zample1_2 Sample

9 |zample1_4 Sample

10

ptions tab.

Injection | Sample

az method
az method
az method
az method
az method
az method
az method
az method
az method

w| ) kyw o ko] o
oo ooooo o

b Make sure that the Quantify and Report check boxes are marked for the

Task(s) to perform.

Sequence |Identification| Description' Report Destination'

R wity

PFriority:
I Mediumn = I

Calibration Maode:

Schedule:

Ready for Analysis

ISingIe Lpdate Calibration

[

[ Sequence Created by

—Taszk[s] ko perfarm

I | Eeauire W Quantify

¥ | Irtearate ¥ Report

[~ Allow Online Editing
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration

Steps Detailed Instructions

3 Enter the destination path for, butdo a Click the Report Destination tab.
not print, the reports: b Clear the Printer check box, if necessary.

Enter Exercise3iii, where “iii" are your © Mark the Path check box, and enter the directory, Exercise3jii.

initials. The system automatically creates this directory if it does not exist and places
the generated reports into the directory Agilent\Cerity\Reports\Pharmaqc\
Reports

Sequencel Identificationl Deseription Fepart Destination |

Fepart(z] ta print

I~ Frinter: I j Select... |
v Path: IExerciseSdef Select... |

4 Select the following reports to be a Mark the Print check box to the left of the Report Types noted on the left
generated: margin.
b Clear all the Print check boxes that are not those noted on the left margin.

Single Injection

Standard Injection

Sequence Frirt Feport Types Feport Template =
= Sample single injection Ini_short. htm
= Standard zingle injection Sin_short.htm
|l Multi-lnjection Summary Group Smp_short. htm
|l Calibration Standards Group Cal_short. htm
|l QC Sample Group GC_shart. him
|l Sample Group SuS_short htm
|l Custom Sample Groups Sum_short. htm L
W Sequence Seq short.htm

5 Save the sequence a Click [ . and enter reasons for changes and your password, if necessary.
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration

Task 3. Run and track the sequence

Steps Detailed Instructions
1 Make sure that the instrument is a Select the instrument for the sequence from the selection tree.
ready. b Make sure the instrument and column are equilibrated, and the conditions
Use the same conditions as set in are the same as those set in the method for the sequence.
the method.
Online Plot settings: Instnument Paned | workis |
Y-Axis range: -20 to 300 B
X-Axis range: 15 minutes [=za sfz | o] @eT EMELES
= [ wlimin
Ol === | o=0
s 1 [ c| o= s [22sc
< v On (it

¢ Click Change at the bottom of the Online Plot.
The Edit Signal Plot dialog box appears.

d Select the detector signal you need from the Available Signals list, and click
Add to place this signal on the right.
Set the Predictable Range as -20 to 300.

f Setthe X-Axis range as 15 min.

g Click OK.

Edit Signal Plot 0]
Available Signals Selected Sighals

iLluaterman Pump: Pressure fa K

Cuaternary Purnp: Flow

Quatemary Pump: %4

Quaternary Pump: %B -

(Quaternary Pump: %C

Quaternary Pump: %0
.|

=
=0
=
\‘/

- YWD Absorbance

' Predictable Rangs " Floating Range
Fom |20 H mas easis nge | o il
Ta 300 :| Ll ffset: | :| %

I | Bt peadiist

i Window Properties

H-axis range: |15 ﬂ mir

™ Diaw Gid

Ok I Cancel Aol
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration

Steps Detailed Instructions

2 Run the sequence. a Expand the instrument folder.
b Select the sequence that you just set up.

The Run button, :k , appears.
¢ Click the Run button.

|J & ° 0| = % y 'Q l§| |J Instrum
E“Alllnstruments j B Sequence Table | Sequence Dptionsl

EK @ Alllnstruments

~ [ =00 muskistpe14 Sample Name Sample Type
Et Ea GetStartlLC

=3 B Single Samplss Calibration

El{ 2 |zamplel_2 Sample
p— 3 |zamplel_d4 Sample
m 4 |Cal Calibration 1
“’:M j |zamplet_2 Sample
3 Monitor the signal, and track the a Select the instrument.
status of the sequence. b Observe the signal in the Online Plot tab, and change the axes if you need to.

Oniine Plot | Logbao: |

VD Absorbance

mau
260 —
200 ,
150 —

00—

Mﬂ | AU

-2 10 5 Bl & 2 min
= Change... | Eaiie: | <

¢ Click the Worklist tab, and observe the status of the sequence.

Instrument Panel  Warklist |

1

Note that the Abort, Pause and Resume buttons appear when you enter the
Worklist.
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration

Task 4. Review the results and reports

Steps Detailed Instructions

1 Review the calibration table and Select Result from the Current View.

a
curve for each revision of the b Select AllSeqNotApprovedRunLast7Days from the Query list.
calibration. ¢ Expand the exer3segqjiii folder.

d

Select the Calibration - exer3seqiii Calib Rev 2 folder.

The calibration table and curve appear in the workspace.

1k Agilent Cerity NDS for Pharmaceutical GA/QC - SCHEIDERER_ROBIN - Administrator - Cerity for Pharma QA-QC

File Edit View Tools Actions Help

Hnmu -Dv\g|@§g\uawm v‘
= # BB 73,5 & 4GB D~
5 eqH ot pprovedRunLast 70 @
a‘l_ eqh othpprovedAunl ast7Days J (73 T
1o [® HBe ooy
= defseqz [Rev 3]
%4 D Caibrations Compound Name | Weighed Amount Comment Signal Short RF (Rsp/Amt)
.| P Calbration - cefauitmethod3 Caib Riev 2 [Rev2]
& “T* Calibraton - defeullmethod3 Caib Rev 3 [Fiev 3] TO D000 VWDTE T2
ey A® Caliration - defauilmethod Caib e 4 [Rev 4] bipheny! 15,0000 VD1 A 214558
{71 0d Revisions
2
Compound Summary
) [dimethyiphthalsts =
i Sample Name | o tons | Weighed Amount | RF (Rsp/A
- call A1 Ve 00000 T
1 Weighed Amount [valid Calbratior]

S s s S
Weighed Amount

SCHEIDERER AOBIN defautmethod3 [EMELC3 [13/18/2002 112259

| [B eaNctbpprove dFunLast7D aps'defseqd [Flev IMCall =

e Select the Calibration - exer3seqiii Calib Rev 3 folder.
f Select the Calibration - exer3seqiii Calib Rev 4 folder.

Cerity NDS Getting Started Guide 35



Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration

Steps Detailed Instructions

2 Review the results for each
calibration standard in each
revision.

Expand the Calibration - exer3seqjiii Calib Rev 2 folder.
Expand the Calibrations folder.

Expand the Call folder.

Select Call #1.

Observe the response factor in the workspace.

Note the different response factors
used to quantify the samples.

a
b
c
d
e

% Agilent Cerity NDS for Pharmaceutical QA/QC - SCHEIDERER ROBIN - Administrator - Cerity for Pharma QA-QC

Eile Edit Miew Tools Actions Help

|| resui ~D-ERER|F REAE| % M| Lo~ % Signal + | [/ Manualintegaion ~ [1a . | 88

= % e #5535 1 ¥ & & Fildown-|

uIAHSeanMppmvedHunLasl?Days RIEN:] Sigrel

N T ETT—

g defseq? [Rev 3] = =

74 2 Calibrations i B

I =T Calbration - defaultmethod3 Calib e [l s n

< 23 Calbrations 8- : g

e B8 cal [Revl] . ®

» P ocall 11 [Rev ] N

fall 23 Samples '

% < Calbration - defaulimethod3 Cai Re (|| 5 -

] < Calbration - defaullmethod3 Calb Re -

{21 0ld Revisions o T —— T I :
o 1 2 3 4
Results

RT Compound Name Amount RF (Rsp/Amt) Peak An
OEH dimethyiphihlate 000 3062 133062
11 diethyiphthalate 7167 3062 387.986
187 biphenyl 15,00 4655 366,982
305 19,956 27.1039 540,052

Expand the Calibration - exer3seqiii Calib Rev 3 folder.
Repeat steps b-c.

Select the second Cal1 standard.

Observe the response factor.

Expand the Calibration - exer3seqjiii Calib Rev 4 folder.
Repeat steps b-c.

Select the third Call standard.

Observe the response factor.

- Ta =

3 —=—
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration

Steps

Detailed Instructions

3 Review the sample results for each
revision.

Note the response factor used for the
quantitation.

4 Review the reports.

Hint: Use the Report Viewer to open
the reports.

a
b
c
d
e
f

Expand the Calibration - exer3seqjiii Calib Rev 2 folder.
Expand the Samples folder.

Expand the Sample1_2 folder.

Select Sample1_2 #1.

Observe the response factor in the workspace.

Repeat steps c-e for Sample1_4.

Signal

WD Absorbance

1,475+ biphsnyl

053

"
w
s
3

L
i} 1

— -

20 oo

Results

AT Compound Name Amount RF (Rsp/Amt) Peak Area Peak Height
5 dmethwiphthalate T T35878 707 0642 4529
il diethylphthalats 7347 435878 545155 316319
&7 bipheryl 4917 24 6553 86 0889 236970
05 5752 27 3947 1280765 22 6674

Expand the Calibration - exer3seqiii Calib Rev 3 folder.
Repeat steps b-f.
Expand the Calibration - exer3seqjiii Calib Rev 4 folder.
Repeat steps b-f.

Select Start > Programs > Agilent Cerity > Report Viewer.

Select File > Open.

Open Cerity > Agilent > Reports > PharmaQC > Reports > Exercise3iii.
Open and view each report.
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration
Task 4. Review the results and reports
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Basic Exercise #3b
Reintegrate and reprocess the results

This exercise contains a series of tasks to help you learn to:
¢ Manually reintegrate the calibration standard results

* Change sample variable values

* Reprocess the sequence with the original method revision

You use the data produced in Exercise #3a.

For the tasks on the following pages, try the steps on the left
without the detailed instructions. If you need more help, follow
the detailed instructions on the right.

Before you start

Read “Running Routine Samples” on page 9.
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Basic Exercise #3b Reintegrate and reprocess the results

Task 1. Make changes to the results and sample information

Steps Detailed Instructions

Select Result from the Current View.
From the Query List, select MySeqNotApprovedRunLast7days.
Expand the exer3seqjiii folder.

1 Find the single injection result for a
b
c
d Expand the Calibration - exer3iii Calib Rev 4 folder.
e
f
9

the third quantitation of sample1_4
in the sequence exer3seqjii.

Expand the Samples folder.
Expand the sample 1_4 folder.
Select sample 1_4#1.

VB [ M B Lot v % Signal v | [ MonuslIntsgration ~ [ s | a5 S |
Signal
MWD Absorbance
T
5 5
T o
.
&
o
!
o 2 3 £ mi
Results
AT Compound Name Amount RF (Rsp/Amt) Peak Area Peak Height
551 dmethhihelte TEn [ T EEEH
11 diethylphthalate 7108 185 925514 313272
T87 Bipheny! 34804 ] 855719 237001
305 4 65GS 273163 107 2068 225340

40 Cerity NDS Getting Started Guide



Basic Exercise #3b Reintegrate and reprocess the results

Steps Detailed Instructions

2 Manually reintegrate the a Click Manual Integration, and select Draw Peak Baseline.
dimethylphthalate peak. A mouse pointer in the shape of a bell curve appears on the chromatogram.
Draw the baseline from the bottom b Place the pointer at the bottom left of the peak at the intersection between
left corner of the peak to the the baseline and peak, and click once.
inflection point on the bottom right of ¢ Ho1d the mouse button down, and move the pointer to the inflection point at
the peak. the bottom right of the peak.

Note that the Amount and RF values  d Release the mouse button.
disappear. The new baseline appears, but the bell curve pointer remains.

e Click the Select Objects button to change the pointer from a bell curve
pointer to a normal pointer.

1 Agilent Cerity NDS for Pharmaceutical 34./QC - SCHEIDERER.ROBIN - Administrator - Cerity for Pharma QA-OC

[0 £ot view Tocks Actions Help —
| Reaut ~0-HES5|k|Ra@E %M E Lot v ® Sigal v [f Menudlnegation ~ I 5 | 4
Jn%ﬁﬂiﬂﬂuﬁflﬁﬁ Fil Down +
| As=etotpprovedRunlas 7D ys @ & Signal
. [® alSeqotpprovedhunsstDays [TT—
W 5 85 defseqd [Rev 4) - m -
K2 (1 Calibrations H b 3
= A" Calibration - defaulmetiod3 Calis ey 2 [Fsw 2] E E 2
& A" Calibation - defaulmetiod3 Calib ey 3 [Fsw 3] B
@ | £ Caliration - defaultmethod3 Calb Fiev 4 [Fiev 4] 2
2 -0 Caibrations °
-~ 1 Samples a
% 2§ samplel2 [Fev 1]

(] Od Revisions

e
w

Results
RT Compound Hame Amount RF (Rsp/Amt)
0.34 dimethylphthalate ) )
m diethylphthalate [ [
1.87 biphen HAA HAA
[ [
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Basic Exercise #3b Reintegrate and reprocess the results

Steps

Detailed Instructions

3 Change sample variable values.

Dilution =5
Purity =.9

a Select the sequence, exer3seqjii.
The sequence table and Sample Entry panel appear in the workspace.
b Select the first sample 1_4 in the sequence.
¢ Click the Amounts tab, and enter a default value for the Dilution factor of 5.
d Enter a default value for the Purity of .9, and click Apply.
e Repeat steps c and d for every sample 1_4 in the sequence.
Sequence Table | Sequence Options |
Sample Hame | Sample Type L(;?rlt;.l Custn(;l:j:mple V:f' Injet;l
1 |can Calibration il 2 1
2 |sample1_2 Sample 5 1
!.Sample 1.4 ple | ]
4 |call Calibration 1 2 1
H  |zample1_2 Sample a 1
b |sample1_4 Sample 9 1
7 |can Calibration il 2 1
8 |sample1_2 Sample 5 1
9 |zample1_4 Sample a 1
Sample Entry | Sequence Logbook
Sample Name: Run  Amourts Idanlilicaliunl Description
Isamplet‘!
[ Sample varables
Sample Type: Sample Amaunt| 01 =
Sampl b
I Anoe J Sample dmount LI mg/ml
Custom Sample Group: Multiplier 1
I J Diltion:| 5
Purity:] .9 LI
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Basic Exercise #3b Reintegrate and reprocess the results

Task 2. Reprocess the sequence results

Steps Detailed Instructions

1 Open the Reprocess window. a Select the sequence, exer3seqiil.
See Chapter 3, “Sample Analysis”, in The Save Reasons for Changes dialog box appears.
the Concepts Guide for a chart that b Enter any information requested, and click Save.

helps you select the correct

| : Select Actions > Reprocess in the top menu bar.
reprocessing option.

2 Select the reprocessing option that  a Select Use the method revision now attached to the result.
uses all other method settings of the b Click OK.

original method, except for the The Cerity system uses the settings of the method originally used to run the
integration settings and default sequence, the new manual integration setting and the new sample variable
sample variable values. values to process the sequence.

In the Cerity system all sample,

-
sequence, method and instrument &
information is attached to the result. Sequence defseq3 - Reprocessed jl
Revision |11
Feprocesz Option:
& {ize the method hat is now_attached to the result
" Use the mast current revision of the method that is attached ta the result
™| Useiintegration setitgs it the methed
" | Beplace Hesponse Factons imthe b ethud
[~ Print Reports oK Cancel
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Basic Exercise #3b Reintegrate and reprocess the results
Task 2. Reprocess the sequence results

Steps Detailed Instructions

3 Track reprocessing until complete. a Select the sequence, exer3seqjii.
b Click the Sequence Options tab.

defzeq? - Reprocessed

Medun 7]

Single Update Calibration |_,

When the system has completed reprocessing, the message “Completed
Reprocessing” appears on the Sequence Options panel

defseq - Reproceszed

Single Update Calibration |—,
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Advanced Exercise #4a
Run a sequence to quantify compounds
with multi-level calibration

This exercise contains a series of tasks to help you learn how to:

e Create a sequence with a method set up for multi-level,
overall calibration, ESTD quantitation and variable
compound amounts

* Enter new information for an individual sample or standard
¢ Edit a sequence during a run

¢ Review the results to view the multi-level, overall calibration
process.

* View the early quantitation single injection reports and the
sequence report
You can choose between two methods to use with this exercise:

* A copy of defexer4iii, the instrument method copied from
the default method provided with the system.

* Exer41i, the method that you created in “Advanced Exercise
#4 Set up a multi-level calibrated method for a sequence” on
page 105.

For tasks on the following pages, try the steps on the left
without the detailed instructions. If you need more help, follow
the detailed instructions on the right.

Before you start

Read “Running Routine Samples” on page 9.

Equilibrate the instrument. See “Basic Exercise #1 Equilibrate
the instrument” on page 11.
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Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration

Task 1. Create a new sequence, and enter sample and sequence

information

Steps

Detailed Instructions

1 Create a new sequence.

Name the sequence exerdseqjii,
where jii are your initials.

Use one of the two methods:

defexerdiii
exerdiii (created with Exercise 4 of
Setting Up Methods)

Enter values for sample amounts and
variables.

For the first sample 1_2, enter:
Sample Amount - 2.5 mg

Dilution Factor - 2
Purity - .93

Enter compound amounts.

To quantify a compound in a sample,
you must select to use the compound
amount for the standard.

For the second set of calibration

standards for dimethyl phthalate,
enter compound amounts:

Cal1-10.17 ug
Cal2 - 37.62 ug

* For detailed instructions, see “Task 1. Create a new sequence” on page 30.

After you create a new sequence, the revision number is set to 1.

Select Instrument from the Current View list.
Expand the instrument folder.

Select exerdseqjii.

Select the first sample 1_2 in the Sequence Table.
Click the Amounts tab.

Enter 2.5 for the Sample Amount.

Change the Dilution Factor value to 2.

Change the Purity value to .93.

=~ T - T — O T — o - U]

Click the Sequence Table tab, and select Cal1 from the second set of
standards.

Enter 10.17 for the Compound amount.

¢ Select Cal2 from the second set of standards.

d Enter 37.62 for the Compound amount.

Sequence T able | Sequence Options |

Sample Name Sample Type Cal. Imme_dia_te Custom Sample| Vial |Injections I\';Jueluﬂr:): =
Level |Quantitation Group # # M i
4 |sample i _d WES B 1 as methiod |(
& |call 1 ) 3 1 ethod (|
cal2 Calloratior B 1 [
7 |sample1_2 B 1 (
8 |samplei_d Sample O B 1 as methiod |(
9 |call Caliaration 1 NG E] 1 as method [(
10 |cai2 Callaration 2 =] z 1 as methiod |(

e o[

Sample Enlty | Sequence Logbook

Sample Name. Run  Amounts | Identification | Description
cal2
I Sample variable Compound amount

Sample Type: Sample Amount] 0 Uss  Mame | Amount
| Caltwation Standard =

Sample Amount Ll ma/m! 7| dimethyiphthall 39.75

Custom Sample Group:

I Il

Muliplier

=}

e bipheryt | 6

.l

Dilution Factar [~ | digthylphthalat 0
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Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration

Steps

Detailed Instructions

4 Enter the tasks to be performed
during the run:

Quantify, Report, Allow Online Editing

5 Enter the destination path for, but do
not print, the reports:

Enter Exercise4iii, where jij are your
initials.

6 Save the sequence

Select the sequence that you just created.

Click the Sequence Options tab.

¢ Make sure that the Quantify and Report check boxes are marked for the
Task(s) to perform.

d Mark the Allow Online Editing check box.

[— -]

Sequence Table Sequence Dptions |
Seauence | Ideniifisation | Desciption | Fieport Destination|

Sequence Nams Fun vith Taskis) to perform
crerdseadec
Priarity: Schedule: I¥ | fcqiic ¥ Quantiy
Instrument:
Medium 2 Ready for Analysis
EMELC3 I | [iegate ¥ Report

Calbration Mode:
Sequence Template

| 0verall Calbration =
Apply
Senuence Created by

* For the detailed instructions, see step 3 on page 32.

* On the Standard toolbar, click [gg]. and enter reasons for changes and your
password, if necessary.

After you save the sequence, the revision increments by one. Here, the
revision number is set to 2.

Cerity NDS Getting Started Guide
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Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration

Task 2. Edit the sequence during the run

Steps Detailed Instructions
1 Run the sequence after the For detailed instructions, see “Task 3. Run and track the sequence” on page 33,
instrument is ready. Steps 1 and 2.

Note that the sequence disappears from beneath the instrument folder.

After you run the sequence, the revision number increments by one. Here, the
revision number is set to 3.

2 Edit the sequence during the run: a Onthe selection tree, select the instrument.

After the last peak comes off during b On the instrument workspace, click the Worklist tab.

the run of the first standard, selectto ¢ Select the sequence.
immediately quantify the first sample d After the last peak comes off during the run of the first standard, click y
1_4in the sequence. in the toolbar.
The sequence in the worklist now says “Preparing to edit”. When the sample
run is complete, the sequence is stopped and the status says “Editable”.

Instiument Panel  ‘Warklist I
MHame Status Type |Method |Priority #| Vial # Desc[iﬁon

1

Instrument Panel WDrkhStl

[ Name | Status [ Type [Method [Priority #] Vial # |Injections # |Description
1 |exerdsequec |Editable |Sequence |exerddec [SO0 |rusm [T

e Expand the instrument folder. (Note that the sequence has reappeared.)
If you do not see the sequence, click the Redo Query button or F5.
f Select the sequence, and select the first sample 1_4 in the Sequence Table.
g Double-click the Inmediate Quantitation cell.
h Double-click Yes.
i Save and run the sequence.
The revision number increments to 4 after you save the sequence.
The revision number increments to 5 after you run the sequence.
j Select the instrument and click the Worklist tab. (The sequence starts with
the second standard.)

Instrument Panel

[ Name | Status [ Type [Method [Priority #] Vial # |Injec‘t|ons#|Descr|ptlon
1 |exer4saqdec|Running(2:1j |Sequence|exer4dec |SDD |N.l’A |N.l’A
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Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration

Task 3. Review the calibration results

Steps Detailed Instructions

a Select Result from the Current View.
Select AllISeqNotApprovedRunLast7Days from the Query list.
¢ Expand the exerdseqjiii folder.

1 Review the calibration table and
curve.

If you ran the sample more than 7
days ago, you must modify the query
to retrieve older results from the d
database. See the online How To help,

One folder appears that contains the calibration and single injection results.
Select any one of the Calibration - exerdseqiii Calib Rev 5 folder.

“Define a query.”

Note that when you first view the

The calibration table and curve appear in the workspace.

sequence result in the Result View, Eelbraton Tabk
the revision number equals the Compound Name | Weighed Amount Comment Stanal Short RF (Rsp/Amt)
number Of saves that you made plus dimethylphthalate 10.000 WD & 10.6703
H H 40.000 10.9812
the number of run executions. In this boheral o0 TE Cira
exercise, the revision number for the £L.00 £od6d
sequence result is 5.
See Chapter 5, “"Sample Analysis”, in
the Concepts Guide for information on
. . .. . Ci i S
sequence and calibration revisioning. S
Id\methylphlhalate ﬂ
i i Sample Name Yalid ‘Weighed Amount RF (Rsp/Amt)
; _ cal Yes 10.0000 0.7547
51 cal Yes 10,1700 05703
cal Yes 10.0000 0.7154
= - cal2 Yes 40.0000 09703
r " . 2 Y 39.7500 1.0560
° = Weished Ameunt oo vee 40,0000 03812
= 2
5 1) 20 Weighed Amount

e View how the system uses the standards in overall calibration to quantify the
samples compared to single-level calibration in Exercise 3a.

Cerity NDS Getting Started Guide
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Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration

Steps

Detailed Instructions

2 Review the single injection results
for both sample 1_2 injections.

Note that the Amount is different for
the first sample 1_2. Why?

The Amount is the compound amount
in the sample. The value for this
exercise represents the compound
amount in the injection times the
values of the dilution factor and
purity. When you entered this sample,
you changed these values.

Expand any one of the Calibration folders.
Expand the Samples folder.

Expand the first sample 1_2 folder.
Select the single injection.

Note the value in the Amount column.

o a0 T o

anria

WD Absarhance

';TG‘__,_ﬁphenyl

o z0

@
B
o
T
2

Results
RT Compound Hame Amount RF [Rsp/Amt) Peak Area Peak Height
0.93 dimethylphthalate 16,6528 109313 95,7303 639187
1.10 diethylphthalate 11.6001 10.9230 70.3073 57.6104
1.65 biphenyl 23.2052 61513 53.4873 42,9007
298 31,9479 68819 2364102 425603
f Expand the second sample 1_2 folder.
g Select the single injection.
h Compare the Amounts from the first and second sample1_2's.
signal
VWD Absorbance
= =
Ep z
A
i e
o 5
I T T
[ 2 4
Results
RT Compound Hame Amount RF [Rsp/Amt) Peak Area Peak Height
0.93 dimethwlohthalate 44,7873 109132 96,5035 69.9118
1.10 digthylphthalate 31.1553 10.8913 £3.8817 &7, 6608
1.08 bipheryl 62,4277 6.0963 52.2814 42 6782
LT oF mo & orao oE BT FERTEDS
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Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration

Task 4. Review the reports

Steps

Detailed Instructions

1 Review the two single injection
reports for the first sample 1_2 and
sample 1_4.

Note that there is only one folder for
each of the second set of samples
because they were not marked for
Immediate Quantitation.

2 View the sample amount for the first
sample 1_2 in the Sequence Report.

a
b
c
d

Select Start > Programs > Agilent Cerity > Report Viewer.

Select File > Open, or click the Open button.

Expand the Exercisediii folder.

Expand the 003 Multi-Injection Summary Group folder, and expand the 01

Sample single injection folder.

Double-click default.htm.

Note the compound amounts.

Expand the 003 Multi-Injection Summary Group 0001 folder, and expand the
01 Sample single injection folder.
Double-click default.htm.

Note the compound amounts.

Repeat steps d-g for the 004 Multi-Injection Summary Group folders.

Click the Open button, and expand the Exercisediii folder.

Expand the Sequence folder, and double-click default.htm.

Sequence samples

Name Position Modified inj. volume|  Amount Unit Cal. level

1 call 9 (A5 Method) 0.0000 mgiml 1
2 cal? 2 [As Method) 0.0000 rmg/mi 2
3 sample 1_2 5 (A5 Method) 26000 mgiml 1
4 sample 1_4 9 [As Method) 0.0000 rmg/mi 1
5 call 9 (A5 Method) 0.0000 mgiml 1
6 cal? 2 [As Method) 0.0000 rmg/mi 2
7 sample 1_2 5 (A5 Method) 0.0000 mgiml 1
3 sample 1_4 9 [As Method) 0.0000 rmg/mi 1
9 call 9 (A5 Method) 0.0000 mgiml 1
10 cal? 2 [As Method) 0.0000 rmg/mi 2
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Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration
Task 4. Review the reports
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC

Getting Started Guide

Advanced Exercise #4b
Change sample variables in the method
and reprocess

This exercise contains a series of tasks to help you learn to:

Change an integration setting in the method.
Remove a calibration point.

Change the sequence so that no sample is immediately
quantified after processing

Reprocess the sequence with the most current method
revision.

Add a new sample variable to the method.
Reprocess the sequence after you add the new variable

Regenerate the reports

You use the data produced in Exercise #4a.

For the tasks on the following pages, try the steps on the left

without the detailed instructions. If you need more help, follow
the detailed instructions on the right.

Before you start

Read “Running Routine Samples” on page 9.

: Agilent Technologies
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Advanced Exercise #4b Change sample variables in the method and reprocess

Task 1. Update the method and result

Steps

Detailed Instructions

1

Change the integration setting in the
method.

Set the Height Reject to 0.

If you are using a copy of the
defexerdiii method, make sure that no
one else has modified it. Check the
old revisions. If it has been modified,
make another copy of the default
method. See “Before you start” on
page 5.

-0 0 T o

Select Method from the Current View.
Expand the exerdiiifolder.

Expand the Data Analysis folder.

Select Integration.

Click the Height Reject cell, and enter 0.
Save the method.

2 Remove the second Cal2 calibration a Select Result from the Current View.
point for dimethylphthalate. b Expand the exerdseqiii folder.
¢ Select the Calibration - Exerdiii folder.
d Click the Calibration cell for the second Cal2 calibration.
e Click the .. button, and double-click the cell to change Yes to No.
Compound Summary
dimethylphthalate j
% - & Sample Hame Cal‘:hall.;?ion Weighed Amom
s s Tes o000
2- cal Ves 0.1700
cal es 0.0000
= - cal2 es 40,0000
I T o 2 N 37.6200
° = Amount cal2 e 40,0000
23 4 . L2
é a 20 Meighed Amount Fl _I
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Advanced Exercise #4b Change sample variables in the method and reprocess

Steps Detailed Instructions

3 Change the sequence so that no a
sample is immediately quantified b
during processing

c
d
e

Select the exerdseqiii sequence.

In the sequence table, double-click the Inmediate Quantitation cell for the

first Samplel1_2.

Double-click No.

Repeat steps b and c for the first Sample1_4.
Save the changed result.

Note that the revision is incremented by 1.

Sequence Table | Sequence Dptions I

Sermirella Meries Ses Trae Cal. |1 _" _‘ Custom Sampl Vial |Injections
Level |Quantitation Group # #
1 1
7 |cal2 Calibration 2 [ille) 3 1
3 |sample1_2 Sample [ille) 5 1
4 |sample1_4 Sample [ille) 9 1
5 call Calibration 1 [ille) 2 1

Cerity NDS Getting Started Guide
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Advanced Exercise #4b Change sample variables in the method and reprocess

Task 2. Reprocess and review the result

Steps

Detailed Instructions

1 Reprocess the sequence with the

most current revision of the method.

Use the integration settings in the
method.
Set up to print (regenerate) reports

2 Make sure the integration change
appears in the reprocessed result.

If you cannot see the calibration
standard chromatogram because of
the example chromatogram, click the
Layout button and clear the Display
Example Chromatogram check box.

a Select the exerdseqiii sequence.

b Select Actions > Reprocess.

Select Use the most current revision of the method that is attached to the
result.

Mark the Use integration settings in the method check box.

Mark the Print Reports check box.

Click OK.

To follow reprocessing, click the Sequence Options tab.

o

e = 0o o

Reprocess E

exerdzeqiws? - Reprocessed

Sequence

=
[
Revision IW 3

Repiocess Oplion:

€ Use the methad revision that is now sttached b the result

= Use the most current revision of the method that is attached to the result

[¥ Use integration settings in the method

[~ Replace Response Factars in the Method

0K | Cancel

a Expand the second Calibration - Exerdiii folder.
b Expand the Calibrations folder and the Cal1 folder.
Select Cal1 #1.

Note that one or more peaks are now integrated and appear in the Results
Table.
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Advanced Exercise #4b Change sample variables in the method and reprocess

Steps Detailed Instructions

3 Review the calibration summary. * Select the second Calibration - Exerd4ijii folder.

Note that the calibration point that you removed before reprocessing is gone.

Compound Surmary

Idimethylphthalale j
g Valid
I ali .
3 Sample Name Calibration Weighed Amounl
a -
cal Wes 0.0000
8 cal Yes 01700
cal Wes 0.0000
- cal2 Wes 40,0000
t T T
0 0 Wreighed Amount cal2 Yes A0.0000
FE! 4 .
w = =
Ea T T
o] 20 ‘Mfeighed Amount
5

4 Review the reports for the first setof a Select Start > Programs > Agilent Cerity > Report Viewer.
samples to make sure thatthey were b Select File > Open.
quantified with all the calibration ¢ Expand Exercise4iii-0001.

standards. Note that only one report exists for all the samples. After initial processing

two reports existed for the first Sample1_2 and Sample1_4.
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Advanced Exercise #4b Change sample variables in the method and reprocess

Task 3. Add a new sample variable to the method and reprocess

Steps

Detailed Instructions

1 Add a new variable to the method.

Add a divisor called “attenuation
factor” with a default value of 3.

2 Reprocess the sequence with the
revised method.
Enter a new value for the
Attenuation Factor of 7 for the first
Sample 1_2.

Set up to print (regenerate) reports.

Select Method from the Current View list.

Expand the current revision of exer4iii.

Select Sample Variables.

Type “attenuation factor” into a Divider cell of the System Sample Variables
table.

Enter a Default Value of 3.

Save the method.

0 oo

-~ o

a Select Result from the Current View list.
b Select exerdsegiii.
Select Actions > Set up reprocessing for new sample entry fields.

Sel up reprocessing for new sample entry fields in the latest method revision

exerdzaqiwes - Reprocessed

Sequence

Revision

i

Wfter you click OK:

1. & news revigion of the result appears in the Selection Tree.

2. The most curent revision of the method is attached to this result.

3. The new zample field: added ta the current method revision appear in the zample entry panel.

Cancel

d Click OK.
The new Sample Entry panel appears.

Click the Amounts tab, and enter 7 for the “Attenuation Factor”.
Select Actions > Reprocess.

Select Use the method revision now attached to the resuit.
Mark the Print Reports check box.

Click OK.

- Ka =-o
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Advanced Exercise #4b Change sample variables in the method and reprocess

Steps

Detailed Instructions

3 Find the report for the first
Sample1_2.

Note that the quantitation value is
different after reprocessing. The
software used the “Attenuation
Factor” in the calculation.

Select File > Open.

-0 o0 T o

The report appears with the new amount for Sample1_2.

Expand Exercise4iii-0002.
Expand the 003Multi-Injection Summary folder.
Expand the 01Sample Single Injection folder.
Double-click Default.htm.

Select Start > Programs > Agilent Cerity > Report Viewer.

VUSD: Absorbance

mil

Sample single injection compounds

RT Compound Peak area| Amount| Unit| Resp.f.| Tailingf.
0.76 S 08370 04600 NiA 0247 Mja
0.94 dimethylphthalate 1241833 2.4779 ug fBRE2 MiA
111 diethylphthalate 1096418 17791 WA 6550 MiA
189 biphenyl 1068904 3700 ug 38360 Mid
31 HiA 163.0633 45837 NiA 4.4362 Mid

Cerity NDS Getting Started Guide
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Advanced Exercise #4b Change sample variables in the method and reprocess
Task 3. Add a new sample variable to the method and reprocess

60 Cerity NDS Getting Started Guide



Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Advanced Exercise #ba
Run a sequence to quantify impurities

This exercise contains a series of tasks to help you learn to
review results and reports of a sequence run with a method set
up for multi-level, bracketed calibration, ISTD quantitation and
variable compound amounts. You learn how to:

¢ Recognize the results of an overall calibration

* Find the system suitability calculations that were selected for
the review layout in the method

¢ Find the custom calculations that were set up in the method

* Review the reports for the calculations that were set up in
the report template

You can choose between two methods to use with this exercise:

¢ instrument method copied from the default method provided
with the system, defexerb.

* method that was created in “Advanced Exercise #5 Set up a
method for a sequence to quantify impurities” on page 117.

For the tasks on the following pages, try the steps on the left
without the detailed instructions. If you need more help, follow
the detailed instructions on the right.

Before you start

Read “Running Routine Samples” on page 9.

Equilibrate the instrument. See “Basic Exercise #1 Equilibrate
the instrument” on page 11.
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Advanced Exercise #ba Run a sequence to quantify impurities

Task 1. Set up and run the sequence

Steps

Detailed Instructions

1 Create a new sequence.

Name the sequence exerbseqjii,

where jii are your initials.

Use one of the two methods:
defexerb

exerbiii (created with Exercise 5 of
Setting Up Methods)

2 Make sure that Quantify and Report
are selected.

3 Enter the destination path for, but do
not print, the reports, and save the
sequence.

Enter Exercisebiii, where “iii" are your
initials.

4 Run and track the sequence.

For detailed instructions, see “Task 1. Create a new sequence” on page 30.

For detailed instructions, see “Task 2. Enter sample and sequence
information” on page 31, Step 2.

For detailed instructions, see “Task 2. Enter sample and sequence
information” on page 31, Step 3.

For detailed instructions, see “Task 3. Run and track the sequence” on
page 33.
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Advanced Exercise #5a Run a sequence to quantify impurities

Task 2. Review the results and reports

Steps Detailed Instructions

Select Result from the Current View.
Select AliISeqNotApprovedRunLast7Days from the Query list.

1 Compare the response factors for
dimethylphthalate for the first set of
bracketed samples with the second Expand the exer3seqjiii folder.
set. Select the second Calibration - exer3seqiii folder.
Hint: If you can’t see the RFs, click the The first calibration folder contains the blank run.

Scroll to see the RFs if not visible.

Select the third Calibration - exerbseqjii folder.

Scroll to see the RFs if not visible.

Compare the RFs.

0 oo

bottom of the Compound Summary
panel to make the scroll bar appear.

Note that the RFs for the second Cal1
and Cal2 for the first set of bracketed
samples are the same as for the first
Cal1 and Cal2 for the second set of
bracketed samples.

e = o

Sample Hame ‘Weighed Amount RF [Rsp/Amt)

call 10.0000 7oAz

call 10.0000 7754

cal2 40.0000 7247 Weighed Amount | RF [Rsp/Amt)

cal? 40.0000 7271
10.0000 7704
10.0000 7727
40.0000 727
40.0000 7248

2 Review the system suitability a Expand the second Calibration - exer3seqiii Calib folder.

calculations for Cal1 #1 under the b Expand the Calibrations folder.

second calibration folder. ¢ Expand the Cal1 folder.

Note the values for the Average d Sele.ct Call #1. o )

Percent Specified Impurity and the e Review the Results Table for the system suitability calculations.

Average Percent Unspecified Impurity You may have to click the bottom of the Results table to see the scroll bar.

calculations that were set up as

custom calculations in the method. Results
RT Compound Mame Peak Width TailingFactor SignalT oNoize Peak resolution
0.94 dimethylphthalate 0.0424 1.144 97.300 I A8
1.1 diethyliphthalate 0.0443 1.080 a3 2.303
1.89 biphenyl 0.0560 0.887 1041.239 9.102
310 0.0305 0665 607,71 9.690

Summary Results
Percent Specified
Impuiity
Percent Unspecified
Impiik

1342

Era:|
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Advanced Exercise #ba Run a sequence to quantify impurities

Steps

Detailed Instructions

3

Review the percent impurity results
for the first Sample1_2 and for the
sample group.

Note that the percent impurity values
exceeded their limits.

a Expand the second Calibration - exer3seqiii folder.
b Expand the Samples folder.
Select the Sample1_2 folder.

Note that the average percent specified and unspecified impurities for both
injections appear here.

Results Table

Compound Name Injectiondt

dimethylphthalate

diethylphthalate

bipheryl

Mot Identified Peaks

Summary Results

Avg Percept Specified 1365

Avg Percent

d Expand the Group Results folder.
e Select Samples.

The results for the average of the percent impurities over all samples appear
here, as do the results of the limit checks for these impurities.

Summary Results

Avg %5 Al Samples 1373
Avg % 5 Al Samples

Limit Check : Mot Passed
Avg % U Al Samples IRT2
Avg % U Al Samples

Limit Check : Mot Passed
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Advanced Exercise #5a Run a sequence to quantify impurities

Steps

Detailed Instructions

4 Review the sample single injection
report for the first Sample1_2 and
the report for the sample group.

a Select Start > Programs > Agilent Cerity > Report Viewer.
b Select File > Open.

¢ Expand Exercisebiii.

d Expand 003Multi-InjectionSummary.

e Expand 01Sample Single Injection, and double-click default.htm.

Note the system suitability calculation values in the table that was set up in
the method.

Re’rent_ion Compound Amount Response) Tailing resolEficEJlrI: SignalToNoise
Time Name Factor| Factor usp

0.93| dimethylphthalate| 24 8892 01169 1178 NiA 237192

1.10| diethylphthalate| 17 bbE1 01189 1136 2,308 194.383

1.89 biphenyl| 375000 00657 1.090 9.129 2564088

3n Wial 486177 00741 1.043 9713 1489322

f Expand Exercisebiii.

g Expand Sample Group, and click default.htm.

Note the percent impurity calculations and limits that were set up in custom
calculations and the report template in the method.

Ayg 2% S All Samples: 1373
Avg % U All Samples: 3772

Sample group limit results

# |Sample name | Compound Limit {Compound}| Limit (Sample)
1| sample1_2 dimethylphthalate OGO | XHOOOOOGOAK
2| sample 1_4 dimsthylphthalate SOCCOOCOCT, | XCOOOOCTOC,
3| sample 1.2 dimethylphthalate SR | FHHA RN
4 | sample1_4 dimethylphthalate SOCCOOCOOCL | XOO00OCON
1| sample1_2 diethylphthalate SR | FHHA RN
2| sample 1_4 disthylphthalate SOCHOOCOOC | XROOOGCIO0L
3| sample 1_2 diethylphthalate SRR | PR R XX
4 | sample 1_4 disthylphthalate SOCHOOCOOC | XROOOGCIO0L
1| sample1_2 hiphenyl KRR | R oK.
2| sample 1_4 biphenyl SOCHOOCOOC | XROOOGCIO0L
3| sample 1_2 hiphenyl KRR | R,
4 | sample 1_4 biphenyl OGO | XHOOOOOGOAK

Avg 2% S All Samples Limit Check: Mot Passed

Avg % U All Samples Limit Check: Mot Passed
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Advanced Exercise #ba Run a sequence to quantify impurities
Task 2. Review the results and reports
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Getting Started Guide

Advanced Exercise #5b
Use a different method to reprocess

This exercise contains a series of tasks to help you learn to:

* set up a different method with a new calibrated compound
* set up reprocessing for a different method

e reprocess the sequence with the different method

You use the data produced in Exercise #5a.

For the tasks on the following pages, try the steps on the left
without the detailed instructions. If you need more help, follow
the detailed instructions on the right.

Before You Start

Read “Running Routine Samples” on page 9.
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Advanced Exercise #5b Use a different method to reprocess

Task 1. Set up a different method

Steps Detailed Instructions

Select File > New > Method.

Click the Browse button in the Method Wizard.

Select exerbiii.

Enter a New Method Name of exerbiii2, and click Next.
Click Next until you reach the New Method Review panel.
Click Finish and click Save.

1 Copy exerbiii and rename it
exerbiii2.
Or, copy defexerb.
Or, use defexerbiii2 to reprocess.

-0 20 T 9o

2 Add diethylphthalate as a calibrated
compound.
Cal Level 1-8 pg
Cal Level 2 - 32 ug
Set biphenyl as the ISTD for this
compound.

a Expand the exerbiii2 folder.

b Expand the Data Analysis folder.

¢ Select Calibration.

d Right-click the calibration table, and select Insert Compound.

e Select diethylphthalate, click > and click OK.

f Inthe calibration table, select diethylphthalate.

g Click on the Level 1 Use Default Amount cell, and click the .. button.

h Select the + sign, and enter 8 pg into the Weighed Amount and Unit cells.
i Repeat steps g and h for Level 2 and 32 pg.

j Select Quantitation.
k Select diethylphthalate.
I Mark the Use ISTD Compound check box, and select biphenyl.
m Save the method.
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Advanced Exercise #bb Use a different method to reprocess

Task 2. Reprocess the sequence result

Steps

Detailed Instructions

1 Set up reprocessing for a different
method.
Select exerbiii2 or defexerbiii2.
See Chapter 3, “Sample Analysis”, in
the Concepts Guide for a chart that
helps you select the correct
reprocessing options.

2 Enter amounts for the new calibrated
compound, diethylphthalate, for
every calibration standard.

Level 1-8

Level 2 - 32

a Select Result from the Current View.

b From the Query List, select MySeqNotApprovedRunLast7days.

¢ Select the exerbseqiii folder.

d Select Actions > Set up reprocessing for a different method.
Sequence exerDzegns - Fepocessed ﬂ

IE

Select Mathod
exerDjmsl

hen you click Ok:
1. & copy of the result appears in the Selection Tree after pou click Reda Query.
2. The method that you selected is attached to the copy of the result
3. The sample entry fields appear in the sample entry panel.

Cancel

e Click Browse, select exerbiii2 and click OK.
f Click OK, and click Save.

A copy of the sequence appears in the selection tree, ready for reprocessing.

This copy is now attached to the new method but has no folders underneath

until it is reprocessed.

AllSegMotdpprovedRunLast 7D aps j
S AllSegMotdpprovedRunLast 7D aps
[ SR Copv 0 =pIC ] [Rev 1]

Copy OF exerbzegiws - Reprocessed [4/12/02 2:45:06 M) [Rev 4]
exerbzegiws - Reprocessed [Rev 11]

Copy OF exerbzegiws - Reprocessed [4/12/02 1:35:31 M) [Rev 5]
Copy OF exerbzeqgiws - Reprocessed [4/12/02 2:09.55 AM)  [Rev 3]
Copy OF exerbzegiws - Reprocessed [4/12/02 1:50:23 AM)  [Rev 3]
exerdzeqiwss - Reprocessed [Rev 18]

En exerdseqws [Fev 8]

Select this copy (note the date and time after it).

|- - '}

Click the Amount tab on the Sample Entry panel in the sequence workspace.

¢ Foreach Level 1 standard, mark the Use checkbox for diethylphthalate, and

enter 8.

d For each Level 2 standard, mark the Use checkbox for diethylphthalate, and

enter 32.
e Save the result.
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Advanced Exercise #5b Use a different method to reprocess

Steps

Detailed Instructions

3 Reprocess the copy.

o | 0o a0

Select Actions > Reprocess

Make sure that Use the method revision now attached to the result is

marked.
Click OK.

Monitor the reprocessing from the Sequence Options panel.
Click the Redo Query button.

Expand the copy.

Select a calibration folder.
Make sure that diethylphthalate is now included as a calibrated compound.

Fle Edi View Iools Actions Help

Result va|ﬂ|@§§|HE|Layuutv|

[
[

O b BB 7.5t R Ao~

uIAHSeqNDlApprDvedHunLast?Days =l (3
]

Al eqNotppiovedRunlastiDays

Calibration T able

w |
& Copy Of exerfseqius - Reprocessed (4/12 - Signal Short
| g Comy O exerfseqis - Fepracessed (4412 || || Compound Name | Weighed Amount Comment o RF Rsp/amt)
| =0 Celtrations
]| o Calibration - swerGjws? Calb R 1 [F TO.0000 VDA i)
f || | G Calibration - exerSiws? Calib Rew 5 [F 40.0000 27
| B Caltration etz Calt Rev s [ dicthylphihialal EEDU[% VWD1A g}g?
— 00 Group Resuls biphenyl 15 0000 VWD A 0000
. {1 0id Revisions 000 o0
cverBsegins - Reprocessed [Rev 11]
Copy Of everSseqius - Reprocessed (4/12
Copy Of exerSseivs - Reprocessed (4/12
Capy Of everSseqius - Reprocessed (412
g2 - [Rev 18]
cverdseqins [Rev 5| Compaund Summany
[ -
g Sample Name | Yald | yreighed 2
ks ol Ves 0
R cal Yes 000
, cal Yes 00l
o cal Yes o
! U.I25 WE\‘!]hEdAmvun(
B >
oo T T
2o 025 Weighed Amount

. ol

SCHEIDERER.ROBIN |EXEI5\WSZ ‘EMELE3 ‘EMHZ/Z[IEIZ 0248:25
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Basic

Advanced

These exercises help you learn how to set up methods for your
laboratory. See Chapter 4, “Method Setup”, in the Concepts
Guide for background information that can help you use these
exercises. The set of basic and advanced exercises includes the
following topics:

Exercise 1 — Set up an equilibration method Learn how to set up
a method template and enter instrument parameters to
equilibrate the instrument.

Exercise 2 — Set up a method for single samples to identify
compounds Learn how to use an example chromatogram to set
up integration and compound identification for single samples.

Exercise 3— Set up a single-level calibrated method for a sequence
Learn how to set up single-level, single-update calibration,
ESTD quantitation, and fixed compound amounts.

Exercise 4 — Set up a multi-level calibrated method for a sequence
Learn how to set up multi-level, overall calibration, ESTD
quantitation, variable compound amounts, and sample
variables.

Exercise b — Set up a method for a sequence to quantify impurities
Learn how to setup ISTD quantitation, custom calculations,
limits, bracketed calibration, and system suitability.

After you set up the methods in Exercises 1-5, you can use them
to run the samples and sequences in Exercises 1-5 of the
section—“Running Routine Samples”.
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Setting Up Methods

72

Before you start

Read “Before you start” on page 5!

Your system administrator must have configured an Agilent
1100 LC series liquid chromatograph for your system.

If you plan to copy a default method to create a new method as
in Exercises 3 and 5, make sure that the default methods are in
your database. From the Query list, select AllMethodsRestored
to view defexerl-5. If they do not appear, see the instructions in
“Before you start” to transfer these methods from the CD-ROM
to your database.
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Basic Exercise #1
Set up an equilibration method

This exercise provides a series of tasks to learn how to:

¢ Create a method template to set up instrument parameters
* Set up instrument parameters

e Save and audit method changes

¢ View the history of method changes

A method template is a framework to let you enter only those
conditions and parameters that you need to acquire and

process data. A method is a method template that contains
entered parameter values.

Use this method to equilibrate the instrument as outlined in the
chapter “Basic Exercise #1 Equilibrate the instrument” on
page 11.

For the tasks on the following pages, try the steps on the left
without the detailed instructions. If you need more help, follow
the detailed instructions on the right.

Before you start

Read “Setting Up Methods” on page 71 for setting up methods.
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Basic Exercise #1 Set up an equilibration method

Task 1. Create a method template to enter instrument parameters

Steps Detailed Instructions

1 Create a new method template fora a Select File > New > Method or click [ and select Method.

single sample. The Method Wizard appears.
Name the method template, b Onthe New Method panel, enter the Method Name, equilmethiii.
equilmethiii, where jii are your ¢ Select Single Sample.
initials.
Method Wizard EHE
New Method ” New Method name :

|equilmethmag

Do you wart ko gelect an existing Method as
a template for the new Method 7

| Browse .

“what kind of Method do you i Single Sample
warnk to create ? -

i Sequence

< Back | Firifshy | LCancel

d Click Next to scroll to the Instrument panel.
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Basic Exercise #1 Set up an equilibration method

Steps Detailed Instructions

a Onthe Instrument panel, select the instrument you need to equilibrate.
The instruments that appear in the Available Instruments list depends on
your configuration of the Cerity Networked Data System.

2 Select the instrument to equilibrate.

Method Wizard

Instrument ” Select the |nstrument for your Method

Available Instruments:

SoftvDT1 =]
[+ 35900F Analog to Digital Converter

Agilent 1100 Series Quaternary Pump

Agilent 1100 Series Standard Autosampler

Agilent 1100 Senes Thermostatted dutozampler

#- Agilent 1100 Series Variable Wavelength Detector

[ Agilent 1100 Series Themostatted Column Compartment
msklc2

B Agilent 1100 Series Diode Anay Detectar

Agilent 1100 Series Diode Amay Detectar [Themastatted |
Agilent 1100 Series Standard Autosampler

[+ gilent 1100 Series Thermostatted Autosampler

DigvDT |
[ 35900E Analog to Digital Converter

<None> b
1] | B

Selected Instument: mskle3

b Click Next to scroll to the Data Analysis panel.

3 Clear all data analysis selections. a On the Data Analysis panel, clear the Compound ldentification check box.

Method Wizard E
Data Anal)r5|5 Da pou want to include
Compound |dentification?
[ pouwant baineElude) I Cafitration and
[Ealiration atd WuaEticatio [antificatiog
Do g it b sz Do J= | Cusstor Caleulations:
[ culEtinns?
[ pouwant barelude Systen I elude Spster
Sutatility Calculstions?: Sriiitatsity
[Ealeulatitre

b Click Next to scroll to the New Method Review panel.
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Basic Exercise #1 Set up an equilibration method

Steps

Detailed Instructions

4 Review and save the method
template.

5 View the Method Wizard settings in
the method.

a 0Onthe New Method Review panel, review the setting in the Method Wizard
Settings section.

b Add the words “Test Comment” in the Comment section.

¢ Click Finish.

Method Wizard | 7] x|

Caomment ta the Method setup:

New Method Review H

Settings made on the "Instrument’’ Panel
Thiz instument was selected: "EMELC"

Settings made on the "D ata Analysis” Pansl
"Compound Identification” was not checked
“Calibration and Quantification’ was not checked
“"Custom Calculations” was not checked
"Include System Suitability Caloulations" was not checked

Test Comment

L]

Method \Wizard Settings:

1

Setlings made on the "New Method" Panel
Title of the new Methad will be “equilmethmag"
"Single Sample’’ was selected

|»

d Click Save if the Save Changes to the Database dialog box appears.

After you save the method template, the Method View appears.
a Select the method you just created - equilmethiii.
b View the Method Description in the workspace.

Notice that the Method Description corresponds to the Comment section of
the New Method Review panel in the Method Wizard.

13. Agilent Cerity NDS for Pharmaceutical A/QC - SCHEIDERER.RODBIN - Administiator - Cerity for Pharma QA-OC
File Edit View Tools Actions Help

Meathad O E ==
) B 7 5= T, % 1 U # FilDown - |
Al astertethods j e Method Marme Ircstrument Name ——
3 i Al astertd ethads quu\lmethmag IEMEI—C3

& Copy of exerimag
4 equimethdec
p equilmethmag
& exerZdec
o exeiZmag
& cxeridec

& everdmag
& crerddec

& smoketest
& testeners
-4 testZexers

I~ Method Description

Settings made on the "Instrument” Panet:
This instrument was selected: "EMELC3"

HWE B

Settings made on the "Data Analysis” Panel:
""Compound ldentification was not checked
""Calibration and Quantification” was not checked
""Custom Calculations” was not checked
"Include System Suitability Calculations' was not checked

L

Test Comment
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Basic Exercise #1 Set up an equilibration method

Task 2. Enter the instrument conditions for the equilibration

Steps

Detailed Instructions

1 Setthe pump parameters:

Methanol as Solvent B:
Flow rate: 2ml/min.
Solvent composition:
80%MeO0H/20%H,0
Stoptime: 10 min.

Acetonitrile as Solvent B:
Flow rate: 1.5ml/min
Solvent composition:
65%ACN/35%H,0
Stoptime: 10 min.

2 Set the autosampler (ALS) injection
volume to zero

a On the selection tree, expand the equilmethiii method folder.

b Expand the Instrument Setup folder and select Quaternary Pump or Binary
Pump.

¢ Enter the Flow as 2 ml/min.

d Under Solvents, mark the B check box and enter 80 in the % box.
The percent of solvent A is automatically set to 20 %.

e Under Stoptime, select the min option and enter 10.

f Under Posttime and Pressure Limits, accept the default values.

L
Setup | Timetable | Auiiay & D ata Euwesl

Flin [~ Stoptime:
Flow: |2 = mlmin " no Limit
i~ Solvent (:IW = min
& )
[~ Posttime:
i
B M [l x| o
(-IU _|: it
(=3 I
i~ Pressure Limit
o T o I i |0 _l; bar Mz |400 _l; bar

a Select the ALS folder.

b Click the Setup tab.

¢ Under Injection, select Standard Injection,
d Set the Injection Volume to zero.

Setup | Auiliary & Timne I

[~ Injection

Injection Yolume: fi] _|; ul

¢ Standard Injsction

© Injection with Meedle Wash st

—

' Use Injector Pragram

Cerity NDS Getting Started Guide
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Basic Exercise #1 Set up an equilibration method

Steps Detailed Instructions

Select the ALS folder,

Click the Auxiliary & Time tab.

Under Stoptime, select the as Pump option.

Select the DAD, MWD, or VWD folder that appears in your detector
configuration.

Under Stoptime, select the as Pump/Injector option.

Select the TCC folder.

Under Stoptime, select the as Pump/Injector option.

Accept default values for all other module parameters

3 Set the same stoptime for all
modules.

Stoptime: 10 min.

20 T 9

o | = o
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Basic Exercise #1 Set up an equilibration method

Task 3. Save and audit method changes

Steps Detailed Instructions
1 Save the method. a On the Standard toolbar, click [&d .
The Cerity administrator must set up The Save Changes To The Database dialog box appears.
auditing for the Save Changes To The
Database dialog box to appear. The Save Changes To The Database HE
Cerity administrator can provide a list
of reasons and require you to enter List of changes
H H [“hange the 'Stoptime' from 'na Limit' to 'as Pumpdrisctor’ for the TCC S etpaint. -
your electronic S|gnature to complete Change the "Stoptime' from "o Limit' to ‘az Pumpdniector’ for the WD Setpoint, _I
i i Change the Flow' from ‘0" to "2' for the Quaterary Pump Setpoint.
the dlalog box. These requ”_ements Change the "Stoptime' from 'no Limit' to '5' for the Quatemnary Pump Setpoint,
can Only appear when a Cerlty GMP Change the 'Solvent D Ratio' from '0' ta 'off' for the Quatemnary Purnp Setpaint.
. .. . . Change the 'Solvent C Ratio' from '0° to 'off' for the Quatemary Pump Setpoint,
license is installed and Audltlng Is set Change the 'Salvent B Ratio' from '0" to '20° for the Quaternary Pump Setpoint.

Change the "Solvent & Ratio' from 100" to *20° for the Quatermnary Pump Setpoint,
Change the ‘Injection Yolume' from 5" to '0" for the ALS Setpaint.
Change the "Stoptime' from 10" ta ‘as Pump' for the ALS Setpaint.

" o

Fieazon for changes

| =

up by the Cerity administrator.

Save I Dizcard | Lancel |

Review the List of changes.
Under Reason for changes, enter a reason or select a reason from the list.
d Click the Save button.

o

2 View the history of changes to the a On the selection tree, select the method, equilmethiii.

method. b View the list of changes to the method.
If you need to use this method before ,
you set up other methods, use the Description Tem [Comment |[ESig  [Timestamp N
. . - Change the 'Stoptime’ from
method with Running Routine o Limit o ‘as
. . Pumpdnjector’ for the TCC Initial
Samplesl BaSIC EXETCISE #1 ’ Setpoint. TCC Setpoint configuration Mone 03/17,/2002, 16:31:51
HH H Change the 'Stoptime’ from
Equilibrate the instrument. e
PumpdInjectar' for the YWD Initial
Setpoint. YWD Setpoint configuration Mone 03/17/2002, 16:31:51
Change the Flow' from 0
to 2" for the Quatemary Initial
Pump Setpoint Quaternary Purmp Setpoint | configuration Mone 03/17,/2002, 16:31:51
Change the 'Stoptime’ from
'no Limit' to &' for the Initial
Quaternary Pump Setpaoint. Quaternary Pump Setpaoint | configuration Mone 03/17/2002, 16:31:51

Individual setpoint changes can only appear in the history of changes when a
Cerity GMP license is installed and Auditing is set up by the Cerity administrator.
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Basic Exercise #1 Set up an equilibration method
Task 3. Save and audit method changes
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Basic Exercise #2
Set up a method for single samples to
identify compounds

This exercise contains a series of tasks to learn how to:

* Create a method template for single samples to include only
compound identification in the method

¢ Set up and save the method to produce an example
chromatogram

* Use an example chromatogram to set up integration

e Set up compound identification

A method template is a framework to let you enter only
conditions and parameters that you need to acquire and
process data.

Use the method created in the first part of this exercise to enter
and run a single sample to produce an example chromatogram.
You can use the completed method to enter and run a group of

samples to identify compounds. See “Basic Exercise #2a Run a

single sample to produce an example chromatogram” on

page 17 and “Basic Exercise #3b Reintegrate and reprocess the
results” on page 39.

For the tasks on the following pages, try the steps on the left
without the detailed instructions. If you need more help, follow
the detailed instructions on the right.

Before you start

Read “Setting Up Methods” on page 71 for setting up methods.
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Basic Exercise #2 Set up a method for single samples to identify compounds

Task 1. Create a method template to identify compounds only

Steps Detailed Instructions

1 Create a new method template fora ¢ Select File > New > Method or click [ ] and select Method.

sin,\‘?le sal:ple. hod I The Method Wizard appears.

ame the method template,
p s d Enter exer2iii in the Method Name box.
exer2iii, where jii are your initials.

e Select Single Sample.

Method Wizard

New Method name

New Method ”

Iexer2\ws

Do you want to select an existing Method az
a template for the new kethod 7

I Browse ..

‘wihat kind of Method do you
wiank to create 7

" Sequence

f Click Next to scroll to the Method Wizard Instrument panel.

2 Select an instrument for the method. a On the Instrument panel, select the instrument that will run the sample.

Method Wizard

Instrument “ Select the Instrument far your Method

Axailable Instruments:

SoftVDT1 =
[+~ 35900E Analog to Digital Corwerter

Agilent 1700 Series Quatemary Pump

Agilent 1100 Series Standard Autosampler

Agilent 1100 Series Thermostatted Avtozampler

Agilent 1100 Series Wariable \Wavelength Detector

- Agilent 1100 Series Thermostatted Column Compartment
msklc2

- Agilent 1100 Series Diode Aray Detector

Agilent 1700 Series Diade Aray Detectar [Thermostatted |
Agilent 1100 Series Standard Autosampler

[+ Agilent 1100 Series Thermostatted Autosampler
DigyDT

[#- 35300E Analog to Digital Converter

<None> i
1] | B

Selected Instrument: mskle3

b Click Next to scroll to the Data Analysis panel.
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Basic Exercise #2 Set up a method for single samples to identify compounds

Steps Detailed Instructions

3 Mark only Compound Identification. a On the Data Analysis panel, Clear the Calibration and Quantification and
Include System Suitability Calculations check boxes.

Method Wizard | x|
Data Analysis
Y Do you want ta include ¥ Compound Identification
Compound |dentification?
Da pou want to include ™ Calibration and
Calibration and Quantification? Quantification

[y et s st = Custom Caleulations

[Cal Bl atins s
Do pou want to include Spstem ™ finclude Spstem
Suitability Calculations? S uitability

Caleulations |

< Back Finiishr LCancel

b Click Next to scroll to the Identification panel.

4 Complete the setup of the method a Click Next, and click the Finish button.
template. b Click Save if the Save Changes to the Database dialog box appears.
Do not mark any check box on the
Method Wizard Identification panel.

Cerity NDS Getting Started Guide 83



Basic Exercise #2 Set up a method for single samples to identify compounds

Task 2. Enter the instrument conditions for the equilibrium

Steps

Detailed Instructions

1 Enter the pump parameters:
Methanol as Solvent B:

Flow rate: 2ml/min.
Solvent composition:
80%MeO0H/20%H,0
Stoptime: 5 min.
Acetonitrile as Solvent B:
Flow rate: 1.5ml/min
Solvent composition:
65%ACN/35%H,0
Stoptime: 6 min.

2 Enter the injection volume and stop
time for the autosampler.

Injection Volume: 1pl

Stop Time: same as pump

a On the selection tree, expand the exer2jii method folder.

b Expand the Instrument Setup folder and select the Quaternary Pump or

Binary Pump.
¢ Enter the Flow as 2 ml/min.

d Under Solvents, mark the B check box and enter 80 in the % box.

The percent of solvent A is automatically set to 20 %.
e Under Stoptime, select the min option and enter 5.

Setup | Timetable I Augiliary & Data Curves I

—Flows —Stoptime;
Flovwr: |2 = mildmin ' no Limit
—Solvent GIS ﬁ miiry
A 20 % I
r~Posttime:
IS
B M fa o
(‘IU _|; ity
c o |
r—Prezsure Limit
o T oK I Min: IU _% bar ax: |4DD _I; bar

On the selection tree, select the ALS folder.

Click the Auxiliary & Time tab.

Under Stoptime, select the as Pump option.

Click the Setup tab and select Standard Injection.
Enter 1pl for the Injection Volume.

D20 T 9

Setup | Auxiliary & Time I

~Injectior

Injection Yolume: [1 _l; ul

% Standard Injzction

" Injgction with Meedle Wash LR

—

€ Use Injector Program
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Basic Exercise #2 Set up a method for single samples to identify compounds
Task 2. Enter the instrument conditions for the equilibrium

Steps Detailed Instructions

On the selection tree, select the VWD folder.
Under Stoptime select as Pump/Injector.
On the selection tree, select the TCC folder.
Under Stoptime, select as Pump/Injector.

3 Make sure the stop time is the same
for all instrument modules.

a
b
Stop Time: same as pump :;

s010min (203 =)
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Basic Exercise #2 Set up a method for single samples to identify compounds

Task 3. Save and audit method changes

Steps

Detailed Instructions

1 Save the method.

After you save the method here, you
can use the method to produce an
example chromatogram.

See “Basic Exercise #2a Run a single
sample to produce an example
chromatogram” on page 17.

Continue with Task 4 after you
produce an example chromatogram.

Save Changes To The Database EHE

a On the Standard toolbar, click [&] .

The Save Changes To The Database dialog box appears.

List of changes

Sequence template updated due to changes in compound calibration bethod. -
Change the 'Compound Mame' from Mew Compoundd’ to ‘o-terphengl’ for the 'Compound’ in the Calibration.
Change the 'Compound Mame' from Mew Compound3' to ‘biphernyl’ for the "Compound' in the Calibration.

Change the 'Compound Mame' from Mew Compound2' to 'disthylphthalate’ for the "Compound' in the Calibration.
Change the 'Compound Mame' from Mew Compound1’ to 'dimethylphthalate’ for the 'Compound’ in the Calibratio
Added Compound Mew Compoundd with Expected Time 307391 366366018, High Time Limit 3.1507615052!
Added Compound Mew Compound3 with Expected Time 1.87937056425805, High Time Limit 192635482831
Added Compound Mew Compound?2 with Expected Time 1.10433877305102, High Time Limit 1.1320087423
Added Compound Mew Compound] with Expected Time 0.934924245150261, High Time Limit 0.958297351;

v
1 | »

Fieazon for changes

Review the List of changes.
Under Reason for changes, enter a reason or select a reason from the list.
Click the Save button.

The Cerity administrator must set up auditing for the Save Changes to the
Database dialog box to appear. The Cerity administrator can provide a list of
reasons and require you to enter your electronic signature to complete the
dialog box.
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Basic Exercise #2 Set up a method for single samples to identify compounds

Task 4. Select an example chromatogram and set up integration

Steps Detailed Instructions

1 Select an example chromatogram. On the selection tree, expand the exer2iii method folder, if necessary.

a
If no chromatogram of the isocratic b Expand the Data Analysis folder.
sample exists, you must run a sample ¢ Select Example Chrom.atogram.
to produce the example d On the Tools toolbar, click Jire

chromatogram. See “Basic Exercise

. Select le chromat
#2a Run a single sample to produce S D e 7]
an examp|e chromatogram" on IAIISampIesNobﬂpprovedﬁunLast?Da}ls j [
page 17. ﬁ A5 amplesMotipprovedRunLast 7D aps
{:I Blanks
You do not need the example =423 Samples
chromatogram to set up integration B defexchiomzs k!
and identification, but it is
recommended. E exerZdec [Rev 2]

--Jf Calibration - exer2dec Calib Rev 2 [Rev 2]

Expand the Samples folder.
Expand the exchromiii or defexchrom2a folder.

Select the sample name with the injection number.
Click the Select button.

o e = o

The example chromatogram appears in the workspace.

Example Chromatogram

VAND: Absorbance

1.910
2.930

[2.324

(S
i
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Basic Exercise #2 Set up a method for single samples to identify compounds

Steps

Detailed Instructions

2

Change the initial event values so
that there are only four integrated
peaks.

a Onthe selection tree, select Integration under Data Analysis.
The example chromatogram appears with the integration events tables.

b Change the Height Reject event value to 1 (or the lowest value that will still
integrate the four main peaks).
¢ Click [ on the Actions toolbar

Example Chramatogram

WD Absorbance
o
E =
i =
- -
e =
& jsd
- =
Ix]
2|
o
T T T
] 2 ] 4 min
Initial Events I Timed Events ] Results
Jvwn =l Gelent | Signal Sh
gnal ort
» - RT Description (Fleat e
Initial Event Hame Initial Event Yalue
Area Reject 0.0000 09349 D A 41595843
Slope Sensitivity 1.0000 11044 W01 A 374 2065
Peak Width 0.0400 1.67%4 WD A I66.2544
Shoulder Detection Mode Dizabled 30739 WDl & 5239433
Height Reject 1.0000

For All Signals

Tail Peak Skim Height Hatio 0.0000
Front Peak Skim Height Ratio 0.0000
Skim Y alley Fatio 20.0000
Baseline Correction Classical
Tangent Skim Mode Standard
Peak to Yalley Ratio 500.0000
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Task 5. Set up compou

Basic Exercise #2 Set up a method for single samples to identify compounds

nd identification

Steps

Detailed Instructions

1 Set up the compound table for the
following compounds:

RT=.91to 1.1, dimethylphthalate
RT=1.1to 1.2, diethylphthalate
RT=1.8 to 2.1, biphenyl

RT=3 to 3.2, o-terphenyl

a On the selection tree, select the Identification item for Data Analysis.
b On the Tools toolbar, click +&-.

The peaks appear with the names New CompoundN in the compound table,
where N=1-4.

¢ Under Compound Name, select the first cell and enter dimethylphthalate.
After you select the cell, enter the name. The previous entry is overwritten.

d Under Compound Name, select the second cell and enter diethylphthalate.
e Under Compound Name, select the third cell and enter biphenyl.
f Under Compound Name, select the fourth cell and enter o-terphenyl.

Compound ] Optiohz I

WD Absorbance
3 ol
£ 3
: f 5
. : g
g : 1
1 "
=
8-
- il U t
T T T T 1
a 1 2 3 4 5 min
Compound Hame| Expected Time| Peak Signal | Time Reference Peak|Use Default Time Window Low Time Limit| High Tim
dimethyl phthalate 0.9308 VDT & + 09667 107
diethyl phthalate: 1.16668 WD A + 11376 1.19
biphenyl 1.9700 WD A + 1.8207 201
o-terphenyl 31861 MWD & + 31065 2.2
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Basic Exercise #2 Set up a method for single samples to identify compounds

Steps Detailed Instructions
2 Save the method. a On the Standard toolbar, click [& .
If you need to run this method to The Save Changes To The Database dialog box appears.
identify compounds before you set up
the other methods in these exercises, |y TN wr w———" [7]x]
use the method with “Basic Exercise
#2b Run a group of single samples to LSt of efizmgEs -
. . ” Sequence template updated due to changes in compound calibration bethod. -~
Identlfy compounds on page 23. Change the 'Compound Mame' from Mew Compoundd’ to ‘o-terphengl’ for the 'Compound’ in the Calibration.

Change the 'Compound Mame' from Mew Compound3' to ‘biphernyl’ for the "Compound' in the Calibration.

Change the 'Compound Mame' from Mew Compound2' to 'disthylphthalate’ for the "Compound' in the Calibration.
Change the 'Compound Mame' from Mew Compound1’ to 'dimethylphthalate’ for the 'Compound’ in the Calibratio
Added Compound Mew Compoundd with Expected Time 307391 366366018, High Time Limit 3.1507615052!
Added Compound Mew Compound3 with Expected Time 1.87937056425805, High Time Limit 192635482831
Added Compound Mew Compound?2 with Expected Time 1.10433877305102, High Time Limit 1.1320087423
Added Compound Mew Compound] with Expected Time 0.934924245150261, High Time Limit 0.958297351;

v
1 | »

Fieazon for changes
i

Save I Dizcard | Lancel |

b Review the List of changes.
¢ Under Reason for changes, enter a reason or select a reason from the list.
d Click the Save button.

The Cerity administrator must set up auditing for the Save Changes to the
Database dialog box to appear. The Cerity administrator can provide a list of
reasons and require you to enter your electronic signature to complete the
dialog box.
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Basic Exercise #3
Set up a single-level calibrated method
for a sequence

This exercise contains a series of tasks to learn how to:

e Create a method template for a sequence to include
single-level, single-update calibration and ESTD quantitation

e Set up calibration and quantitation with fixed compound
amounts

¢ Set up a sequence template

A sequence template is a sequence table containing the order of
calibration standards and samples that you need to run with
this method. A sequence template is useful if the order, sample
names and characteristics are similar every time you run a
sequence with this method.

You can use this method with “Basic Exercise #3a Run a
sequence to quantify compounds with single-level calibration”
and “Basic Exercise #3b Reintegrate and reprocess the results”.

For the tasks on the following pages, try the steps on the left
without the detailed instructions. If you need more help, follow
the detailed instructions on the right.

Before you start

Read “Setting Up Methods” on page 71 for setting up methods.
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Basic Exercise #3 Set up a single-level calibrated method for a sequence

Task 1. Copy a method to create a method template for a sequence

Steps

Detailed Instructions

1 Create a new method template from
an existing method.

Name the method template,
exer3jii, where jij are your initials.
Use exer2iii or defexer2 as the
template for the new method
template.

Make sure that only Compound
Identification and Calibration and
Quantitation are marked.

You copy a method when you want to
keep the instrument and data analysis
settings from the old method. You do

not have to take the time to enter the
settings into the new method.

a Select File > New > Method or click L] and select Method.
The Method Wizard New Method panel appears.
b Click the Browse button and select exer2iii or defexer2 from the Method

Template Selection dialog box.

¢ Enter exer3iii in the New Method Name box.

d Select Sequence.

Method Wizard [2]
New Method ” Newy bethod name :
Iexer3\ws
Do you want to select an existing Method ax
a template for the new Method ?
Iexeerec Browse ...
‘wihat kind of Method do pou ™ Single Sample
want to create 7
e Click Next until you reach the Data Analysis panel.
f Mark the Calibration and Quantitation check box.
Method Wizard E
patatanalisis Do you want ta include [V Compound |dentification
Compound |dentification

Calculations?

Caleulation?

Do pou want to include
Calibration and Quantification?

Do you want to use Custom

Do pou want to include Moise

Do pou want to include System
Suitability Calculations?

¥ Calibration and
Quantification

™ Custom Calculations

™ Include Naise
Calculations

I~ linclude Spstem’
Suitahility
iCalculations
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Basic Exercise #3 Set up a single-level calibrated method for a sequence

Steps

Detailed Instructions

2 Make selections to keep the
compound table and set up new
calibration.

Make selections to set up:
single-level calibration

fixed compound amounts
single-update calibration
sequence-specific calibration

a Click Next to scroll to the Compound Table panel.

b Select the Keep Compound Calibration from Method template option.
This option lets you keep the compound table from the previous method
(even though no calibration was set up).

Method Wizard

Compound Table “

¢ Click Next to scroll to the Identification panel.

d Do not mark any check boxes on the Identification panel.
e Click Next to scroll to the Calibration panel.

f Select Fixed Amount and use the default options.

Method Wizard

Calibration H

[2]x]
How do you want the calibration to be set up?
€ Set up a new Compound Calibration.
€ Set up a new Manual Calibration
= Keep Compound Calibration from Method template.

Do the standards in your ~ Yariable Amount
method always contain Fiked & Fired &
Amaunts or Variable Amounts? Tl A

Does this method use more than
one concentration level of the I MuliLevel |2

calibrated compound(s|?

Wihat kind of Calibration do " Owerall Calibration
yau need? 1+ Single Update Calibration
i~ Bracketing
what kind of Calibration i Instument Specific
Procedure do you need? Calibration
¥ Sequence Specific

Calibration

Cerity NDS Getting Started Guide
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Basic Exercise #3 Set up a single-level calibrated method for a sequence

Steps Detailed Instructions

3 Set up Quantitation and review your a Click Next to scroll to the Quantitation panel.
new method. b Make sure that the Limit checks check box is clear and the ESTD option is

selected.

Method Wizard

Quantitation H

Do you want to include limit checks ..
aon the calculated results ? I Limit checks

Which Calibration Mode do you (= ESTD
want ta use in your Methad 7 15T

< Back.

Eitrish | Cancel |

¢ Click Next to scroll to the New Method Review panel.
d Review the Method Wizard Settings.
e Click the Finish button to save your new method.

9
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Basic Exercise #3 Set up a single-level calibrated method for a sequence

Task 2. Select an example chromatogram

Steps Detailed Instructions
1 Select an example chromatogram. a On the selection tree, expand the exer3iii folder.
Use the example chromatogramyou b Expand the Data Analysis folder.
produced with Basic Exercise 2aor ¢ Select the Example Chromatogram item.
2b of the “Basic Exercise #3aRuna d On the Tools toolbar, click |f#.
sequence to quantify compounds
with single-level calibration” and e ———— ol
“Basic Exercise #3b Reintegrate ‘QSAT;Im:IU:\IDDrADDde;‘ZD[;Dy |
and reprocess the results”. -g ple
Or, use defexchrom2a. 00 deehonze el
You do not need to select an example B et e
chromatogram. However, it is easier e Cabraton - ene2ded Cab e 2[R 2
to modify compound identification if
you do.

I otppravedAunL ast7D. ol hom2a [Rev 2ldefenchion2a #1 [Rev 1]

e Select the sample name with the injection number to produce the example
chromatogram.
f Click the Select button.

The example chromatogram appears in the workspace.

Example Chromatogram

WD Absorb ance

191

3.230

=]
o
G2
=N
=y

u]

w ':::-1.994

After you have selected the example chromatogram, you can see the
integration and identification settings that belong to the original method.
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Basic Exercise #3 Set up a single-level calibrated method for a sequence

Task 3. Modify compound identification

Steps Detailed Instructions
1 Remove a compound from the a Onthe selection tree, select Identification under the Data Analysis folder.
compound table. b Select the o-terphenyl cell.

Remove the o-terphenyl compound. ¢ Right-click the o-terphenyl cell and select Remove Compound.

Compound I Options I

WD Absorbance

200 ALl
1
1002 oim o thy D iEEE
il

2
8
g2
D 1N
T T
o] 1 2 3 4 min
Compound Mame| Expected Time| Peak Signal | Time Reference Peak|Usze Default Time Window
dimethylphthalate 1.0160 WDl A - +
digthylphthalste 11910 WD A - +
bipherivl 1.9344 WD & 2 +
4 | 3
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
Task 4. Set up calibration

Task 4. Set up calibration

Steps Detailed Instructions

1 Set up calibration for a On the selection tree, select Calibration under the Data Analysis folder.
dimethylphthalate. b On the calibration table, select dimethylphthalate.
dimethylphthalate - 10ug ¢ On the Options tab, enter 10 in the Weighed Amount box and pg in the

Amount Unit box.

[

D
Quantitation
Compound Hame Weighed Amount Bazed On

dimethylphthalate 10.0000 | aea |
dethylphthalate 0.0000 T aea |
15.0000 _aea |

e

dimethylphthalate

I
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
Task 4. Set up calibration

Steps Detailed Instructions

2 Set up calibration for biphenyl. a On the calibration table, select biphenyl.
b On the Options tab, enter 15 in the Weighed Amount box and pg in the

Biphenyl - 15pg
Amount Unit box.

e =]
Quantitation
Compound Name Weighed Amount Based On

dimethylphthalate 10.0000 | aea |
digthyiphthalate [ aea |
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Basic Exercise #3 Set up a single-level calibrated method for a sequence

Steps

Detailed Instructions

3 Remove diethylphthalate from the
calibration table.

a On the calibration table, right-click anywhere and select Remove Compound
from the shortcut menu.

The Select Compound(s) dialog box appears.

b In the Calibration Table list, select diethylphthalate.
¢ Click the < button to put diethylphthalate in the Available Compounds list.
d Click the OK button.

. Select Compound(s)
Ay ailable Compounds Calibration T able
diethwlphthalate dimethylphthalate
biphenyl
S |
N
[
Compound Info :
ok Cancel
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Basic Exercise #3 Set up a single-level calibrated method for a sequence

Task 5. Set up quantitation for all four peaks

Steps Detailed Instructions

1 Base the quantitation of a On the selection tree, select Quantitation Setup under the Data Analysis
diethylphthalate on folder.
dimethylphthalate. Click the Uncalibrated Compounds tab.
Use an amount multiplier of .8. Under Compound Calibration Type, select the Use Compound option.
Select dimethylphthalate from the Use Compound list.
Enter .8 in the Amount Multiplier (Compound) box.

O 220 T

Calibrated Compounds ] Uncalibrated Compounds I Unidentified Peaks ]

c Eumpnund Am[tEunl MulliE‘Iiel RF (Rsp/Amt)

Type Compound Group

Compound Hame | Expected Time

diethylnhthalate 11044 dimethylphthalat .. 1.0000 [Ny

Compound Mame diethylphthalate

Compound Calibration Type Compound Group

& sz Compound Idimethy\phthalale =] [Mane B Mew
Amount Multipher [Compound] q
¢ Manual Response Factor His Campound Info

€ No Quantification |
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
Task b. Set up quantitation for all four peaks

Steps Detailed Instructions
2 Base the quantification of the a Click the Unidentified Peaks tab.
unidentified peak on biphenyl. b Under Use for Quantitation, select the Use Compound option.

¢ Select biphenyl from the Use Compound list.

Use an amount multiplier of .9.
d enter.9 in the Amount Multiplier (Unidentified Peak) box.

Amount Multipher

i
Peak]

Not | dertified Peaks I 1.0000

[bpreryi 7]
EN—
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Basic Exercise #3 Set up a single-level calibrated method for a sequence

Task 6. Set up the sequence template

Steps

Detailed Instructions

1 Enter the following calibration
standards and samples into the
sequence template:

Cal1- full-strength isocratic standard

Sample 1_2 - isocratic standard
diluted 1/2 with methanol
Sample 1_4 - isocratic standard
diluted 1/4 with methanol

You cannot set up a sequence
template with calibration standards
until you have set up calibration in
Data Analysis.

a On the selection tree, select Sequence Template for the method.
b On the sample table, enter the calibration standard for row one.

Enter Call in the Sample Name box.

Select Calibration Standard from the Sample Type list.

Enter the Vial# where this standard is located in the ALS.

Click the Apply button to put the sample information into the sample table.
¢ Enter sample 1_2 for row two.

Select Row 2 in the sample table.

Enter sample 1_2 in the Sample Name box.

Select Sample from the Sample Type list.

Enter the Vial# where this sample is located in the ALS.

Click the Apply button to put the sample information into the sample table.
d Enter sample 1_4 for row three.

Select Row 3 in the sample table.

Enter sample 1_4 in the Sample Name box.

Select Sample from the Sample Type list.

Enter the Vial# where this sample is located in the ALS.

Click the Apply button to put the sample information into the sample table.

. L Injection Sam
Cal. |Summary| Vial |Injections ] H
Sample Name |Sample Type Level | Grou " 4 Volume Amo
’ il |[mgin
1 |Call Calibration 1 2 1 az method |0
2 |zample1_2 Sample 5 1 az method |0
3  |zampl=1_4 Sample g 1 &% method 0

102

Cerity NDS Getting Started Guide



Basic Exercise #3 Set up a single-level calibrated method for a sequence

Steps

Detailed Instruction

S

2 Enter two more sets of Cal1,
sample1_2 and sample 1_4 into the
template.

Hint: Use the Fill Down Wizard and
Copy command.

The standards and samples in the
final template appear in the following
order:

calibration standard
two samples,
calibration standard
two samples,
calibration standard
two samples

a Click Fill Down on the Edit toolbar, and select Fill Down Wizard.

The Fill Down Wizard appears.

b Under Range, select Append, enter 6, and click Next.

Fill Down Wizard

Fill Range

‘what Range do you want to be used 7

Range

© All raws

" Rows: 1

Enter row numbers and/or 1ow ranges
seperated by commas. For example, 1,7,10-15

(* Append: |G

ity LCancel |

¢ Onthe Sample Names panel, enter callin the Name box, and click Next.
d On the Vial Numbers panel, clear the Define Vial numbers? check box, and

click Finish.

e When the Apply Sample Changes dialog box appears, click Yes.
See that the six new rows display copies of the first row of the template.
f Select the two samples on lines 2 and 3, and click the Copy button on the Edit

toolbar.
g Selectrows 5 and 6, and click the Paste button on the Edit toolbar.
h Selectrows 8 and 9, and click the Paste button on the Edit toolbar.
. i Injection | Samp
Sample Name |Sample Type L(t::rll;I S'g?;:?lw V:.‘ial InJet:lons Yolume [Amoy
1] |[my/n
1 |Call Calibration 1 2 1 as method |0
2 |sample1_2 Sample 5 1 az method |0
3 |zample1_4 Sample 9 1 as method 0
4 |Cal Calibr ation 1 2 1 as method |0
5  |zample1_2 Sample 3 1 as method |0
6 |zample1_4 Sarmple 9 1 as method |0
7 | : T ethod |0
8 1
9 1
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Basic Exercise #3 Set up a single-level calibrated method for a sequence

Steps

Detailed Instructions

3 Set how the calibration will be
updated:

First Cal1- Replace (both RF and RT)

Second Call - Average for RF and
Floating average for RT (Weighted
60% after RT)

Third Cal1 - Average for RF and
Floating average for RT (Weighted
75% after RT)

4 Save the method.

After you complete this method, you

may use it to run a sequence. See

“Basic Exercise #3a Run a sequence

to quantify compounds with
single-level calibration” on page 29

and “Basic Exercise #3b Reintegrate

and reprocess the results” on
page 39.

a
b
c

On the sequence table, select the first Call.
Click the Run tab.
Under Calibration, select Replace from the Response Factor Update list and
select Replace from the Retention Time Update list.

Select the second Cal1 in the sequence table.

Select Average from the Response Factor Update list and Floating average
from the Retention Time Update list.

0,
Select 60%.
g Repeat steps d and e for the third Call.
. Injection
Cal. Custom S 1 Vial S 1 "
Sample Name |Sample Type | | J°0, Group ¥ ® VD[I':JI;ne Amonnt Multip]
1 call Calibration 2 1 &S method |0 1
2 =ample1_2 5 q == method |0 1
3 sample 1_4 E 1 as method |0 1
4 on =z T 0 1
=ample 1_2 Sample 5 1 == method | O 1
sample 1 _4 Sample a9 1 &S method |0 1
call Calibration 2 1 as method |0 1
sample 1_2 Sample = 1 as method O 1
sample 1 _4 Sample a9 1 &S method |0 1
10

a Click [id. and enter your reasons for changes and electronic signature,

Sample Name:

[=art

Sample Type:

[ Calibration Standard

Custom Sample Group:

“ial Murnber

Injections

= |

- Mevs

Walume [ul]

[2

1

necessary.

[as method

Run

Amounts | Identifisation | Description |

[ Calibratiors

Calibration Mode: Single Lipdate

Calibration Level
1 ~

Fiesponse Update:
Average ~

Retention Time Update:

[Fioating foverage

if
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Advanced Exercise #4
Set up a multi-level calibrated method
for a sequence

This exercise contains a series of tasks to learn how to:

* Use an existing method to create a new method template for
a sequence

¢ Include multi-level, overall calibration and ESTD
quantitation in the method

e Set up calibration and quantitation with variable compound
amounts for a calibration table with two levels

e Set up system sample variables
* Set up a sequence template for overall calibration
* Select a new report template for a single standard injection

report

See “Basic Exercise #3 Set up a single-level calibrated method
for a sequence” on page 91 to learn what a sequence template is.

You can use this method with “Advanced Exercise #4a Run a
sequence to quantify compounds with multi-level
calibration” on page 45 and “Advanced Exercise #4b Change
sample variables in the method and reprocess” on page 53.

For the tasks in this exercise, try the steps on the left without
the detailed instructions. If you need more help, follow the
detailed instructions on the right.

Before you start

Read “Setting Up Methods” on page 71 to set up methods.
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Advanced Exercise #4 Set up a multi-level calibrated method for a sequence

Task 1. Copy a method to create a new method template for a sequence

Steps Detailed Instructions
1 Copy the method to create a new a Select File > New > Method or click ] and select Method.
template. The Method Wizard appears.

Copy either exer3iii or defexer3.
Name the method template,
exerdiii, where jii are your initials.
Change nothing until you reach the
Compound Table panel.

b Onthe New Method panel, click the Browse button, and select exer3iii or
defexer3.
¢ Enter exer4iii in the New Method Name box.

Note that the Method Wizard panels e e
. . ew Metho
contain the method selections from Mew Mathod name :
Exercise 3. Iexer4eme
Do you want to select an existing Method as
a template for the new Method 7
exerdzinglevel Browse ... |
what kind of Method do you  Single Sample
want to create 7 =
* Sequence
I
d Click Next until you reach the Compound Table panel.
2 Set up the Compound Table panel. a 0Onthe Compound Table panel, select Set up a new Compound Calibration.
Because you will set up a multi-level
o
calibration, you set up a new
calibration table. Compound Table H How do you want the calibration to be set up?
& Set up a new Compound Calibration

' Set up a new Manual Calibration.

" Keep Compound Calibration from Method template.

b Click Next until you reach the Calibration panel.
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Advanced Exercise #4 Set up a multi-level calibrated method for a sequence

Steps Detailed Instructions

3 Set up the calibration panel. a Select Variable Amount.
b Mark the Multi Level check box, and enter 2 levels.

Choose to set up:
¢ Select Overall Calibration.

multi-level calibration (2 levels)

variable compound amounts YETT— BE

overall calibration
sequence-specific calibration Calibration Do the standards in your & Variable Amaunt

method always contain Fized X
Amountz or Yariable Amounts? " Fixed Amount

Does this method use more than
one concentration level of the ¥ bult Level |2
calibrated compound|z]?

what kind of Calibration do & Overall Calibration
you need? " Single Update Calibration
" Bracketing
‘what kind of Calibration ' Instrument 5 pecific
Procedure do you need? Calibration
&' Sequence Specific
Calibration
Firrety | Lancel

d Click Next until you reach the New Method Review panel.

4 Review your new method template. a Onthe New Method Review panel, review the Method Wizard Settings.
b Click the Finish button to save your new method.
¢ Save all changes to the database, with a reason if necessary.
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Advanced Exercise #4 Set up a multi-level calibrated method for a sequence

Task 2. Set up example chromatogram and compound identification

Steps

Detailed Instructions

1 Select an example chromatogram.

Use the example chromatogram that
you produced with “Basic Exercise
#3a Run a sequence to quantify
compounds with single-level
calibration” and “Basic Exercise #3b
Reintegrate and reprocess the
results”.

Or, use defexchr2a. (To use this
chromatogram, use an instrument
with a VWD detector.)

If you cannot see the sample whose
chromatogram that you want to
select, select another query.

Hint: The result, defexchr2a, is a
restored result.

a On the selection tree, expand the new method template, exer4iii.
b Expand the Data Analysis folder and select Example Chromatogram.
¢ On the Tools toolbar, click fif.

The Select example chromatogram dialog box appears.

Select example chromatogram EHE
IAI\SampIEsNULi\DprUvedHunLaslTDays j
AllS amplesM otépprovedRunlast 7D aps

] Blarks

B-{_] Oid Revisions
B exmi2dec [Rev2)
-1 Calibration - exer2dec Calb Rev 2 [Rev 2]

coc |

d Select the injection from the analysis that contains the example

chromatogram for the new method. If you do not see the defexchrom2a under

the Samples folder, select the query, AllResultsRestored.
e Click the Select button.

The example chromatogram appears in the workspace.

E=ample Chromatagram

VU Absorbance

195
1.910
2.930

[2.324

The integration parameters are retained from the Exercise 3 method. You do

not have to set up integration.
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Advanced Exercise #4 Set up a multi-level calibrated method for a sequence

Steps Detailed Instructions

2 Set up the compound table for these a On the selection tree, select ldentification under the Data Analysis folder.

compounds: b On the Tools toolbar, click .

RT=0.9-1.1 min, dimethylphthalate The peaks appear with the names New Compound one through four in the
RT=1.1-1.3 min, diethylphthalate compound table.

RT=1.8-2.0 min, biphenyl ¢ Under Compound Name, select the first cell and enter dimethylphthalate.
Do not identify the fourth peak. In After you select the cell, enter the name. The previous entry is overwritten.

Under Compound Name, select the second cell and enter diethylphthalate.
Under Compound Name, select the third cell and enter biphenyl.

Under Compound Name, right-click the fourth cell.

Select Remove Compound.

another exercise, you will set up the
fourth peak as an unspecified impurity
that is not identified based on
retention time.

e = o o

On the Identification workspace, view the three identified peaks and one
unidentified peak.

Compound I Options ]

WD Absorbance

) &l f
T 5 2
=
e
2z =
i
= =
8
8
g2
c, N
T T
o] 1 2 2 4 min
Compound Mame| Expected Time| Peak Signal | Time Reference Peak |Uze Default Time Window
dimethylphthalate 1.0160 WD A - +
disthwiphthalate 11910 WD A - +
bipherl 1.9344 WVWDT A - +
| »
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Advanced Exercise #4 Set up a multi-level calibrated method for a sequence

Task 3. Set up calibration and quantitation

Steps Detailed Instructions
1 Set up calibration for a Onthe selection tree, select Calibration under the Data Analysis folder.
dimethylphthalate and biphenyl. b Onthe Compounds table, select dimethylphthalate.

Default amounts for On the Options sheet, click the Use Default Amount cell and select +.

dimethylphthalate: When you make this selection, the amount that you enter in the Weighed

Level 1-10pg Amount cell for each level appears in the Amounts sheet in Sample Entry.

Level 2 - 40pg d Forlevel 1, enter 10 in the Weighed Amount box and L.g in the Amount Unit

Default amounts for biphenyl: box. _ ]
e Forlevel 2, enter 40 in the Weighed Amount box.
Level 1 - 15ug .
f Repeat steps c-e for biphenyl.
Level 2 - 60pg
Wh_en you set upa method with Compaurds I Default Calibration Curve I
variable compound amounts, the
. . Use Default Quantitation
apphcatlon lets you enter the actual Compound Name Level Id Weighed Amount Amount Amount Unit Based On
weight (concentration) of the Smethyphihalate i To00m T o en
. 2 40.0000
standard compounds in sample entry. Tethyiphihalate i 70000 - aea
2 0.0000
hipheryl 1 15.0000 + ug area
2 60.0000
Options I Calibration Curve I
Compound Nam: Ihiphenyl
Use Default
Level Id Weighed Amount Amount Amount Unit Low Amount Limit| Use Low L
1 15,0000 + ug 14 7800
2 60,0000 57.0000
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Advanced Exercise #4 Set up a multi-level calibrated method for a sequence

Steps Detailed Instructions

2 Remove diethylphthalate from the a On the calibration table, right-click anywhere and select Remove Compound
calibration table. from the shortcut menu.
The system has automatically added The Select Compounds dialog box appears.
all compounds from the compound |, | the Calibration Table list, select diethylphthalate.

identification table to the calibration ¢ cjick the < button to put diethylphthalate in the Available Compounds list.

table. d Click the OK button.
In this step, remove diethylphthalate
to use it as an uncalibrated compound  EEEIEEERRLILILIC)
that is quantified based on the Awailable Compounds Calibration Table
response factors of a different diethylphthalate dimethylphthalate
compound. N | biphenyl

|

L

Compound Info ;
ak. Cancel
3 Set up quantitation as you did in See “Task b. Set up quantitation for all four peaks” on page 100.

Exercise 3.
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Advanced Exercise #4 Set up a multi-level calibrated method for a sequence

Task 4. Set up system sample variables

Steps

Detailed Instructions

1 Set up a multiplier called “dilution
factor”.

Use a default value of 5.

2 Set up a divisor called “correction
factor”.
Use a default value of 2.

On the selection tree, select Sample Variables.
Double-click the Dilution cell, and add the word Factor.
Enter a default value of b.

Click the Divisor cell once, and enter the name, Correction Factor.
Enter a default value of 2.

Syztem Defined S ample VWariables [Set by the uzer in Sample Entry and uzed in quantification]

. . Default
Variahle ID Display Name Value
1 |Multiplier_1 Multiplier 1
2 |Muttiplier_2 Dilution Factar &
3 |Muttiplier_3 Purity 1
4 |Muttiplier_4 1
f  |Muttiplier_5 1
6 |Divider_1 Correction Factar 2
7 |Divider_2 1
8 |Divider_3 1
9  |Divider_4 1
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Advanced Exercise #4 Set up a multi-level calibrated method for a sequence

Task 5. Edit the sequence template

Steps

Detailed Instructions

1 Edit the template to look like this:
two calibration standards (Lev1,2)
two samples,
two calibration standards
two samples,
two calibration standards

You cannot set up or edit a
sequence template with
calibration standards until you set
up calibration in Data Analysis.

2 Set up to quantify the first sample,
Sample 1_2, immediately.

When you make this selection,
Sample 1_2 will be quantified using
the first set of calibration standards.
Sample 1_2, along with the other
samples, will also be quantified at a
later time using the average of all the
calibration standards.

Note that the sequence template still contains the information for the method
from Exercise 3 but no longer identifies calibration standards.

On the selection tree, select Sequence Template.

On the sample table, select the calibration standard for row one.
Select Calibration Standard from the Sample Type list.

Move to another row or click the Apply button.

Repeat steps b-d for the next two standards.

Select the standard in the first row.

Click the Insert button in the toolbar.

Change the Sample Name of the second standard to Cal2.

Set the Vial# to 3 and the Calibration Level to 2.

Click Apply.

Repeat steps g-j for the next two standards.

Select the last two sample rows, and click the Delete button.

i - B - T — O T — - U]

Double-click the cell for Sample 1_2 under the heading, Inmediate
Quantitation.
b Double-click the Yes that appears.

D

Cal. |1 liate |Custom Sampl Vial |Injections
SampleiilamelSamplgvie Level |Quantitation Group # #
1 |call Calibration 1 [ille) 2 1
7 |cal2 Calibration 2 [ille) 3 1
3 |sample1_2 Sample YES 5 1
4 |sample1_4 Sample [ille) 9 1
5 call Calibration 1 [ille) 2 1
6 |cal2 Calibration 2 [ille) 3 1
7 |sample1_2 Sample [ille) 5 1
8 |sample1_4 Sample [ille) 9 1
9 cal Calibration 1 [ille) 2 1

an
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Advanced Exercise #4 Set up a multi-level calibrated method for a sequence

Steps

Detailed Instructions

3 Use the default compound amounts
for all standards.

a Click the Amounts tab on the Sample Entry panel
b For each calibration standard:
Select the standard in the sequence table.

Under Compound amounts, mark the Use check boxes for

dimethylphthalate and biphenyl.

Cal. | Immediate Custom Sample| Vial |Injections 0 EClion Samp

Setiilln e Satiil Ui Level |Quantitation Group # VD[I:I;“ Amou
1 |cail Calibration MO 2 1 as method |0
2 csl2 Calibration N 3 1 as method |0
3 ssmple1 2 Sample YES 5 1 as method |0
4 |zemple1_4 Sample [i[od] el 1 a3 method |0
5 cah Calibration MO 2 1 as method |0
[ Calibration MO 3 1 as method |0
7 sample1_2 Sample MO 5 1 as method |0
8 =smple1_d Sample MO 9 1 as method |0
9 csh Calibration N 2 1 as method |0
1 ]

Corection Factor,

10

11
Sample Name: Run Amounts Idenl\llcalmnl Description

Ical2

~Sample varables———————————————

Sample Type: Sample Amount| 0

IEahblallun Standard j

Sample Amount Ul mag/ml

Custom Sample Group: Muliier, 1

I j Mew

Dilution Factor| &

Wial Number  Injections Wolume [pl] Puirity:] 1

|3 IT Ias method

rCompound amounts————————————

Use Marme Amournt
[ | dimethyphthalate [u) 40
- diethylphthalate: | 0
=l biphenyl [ug]:| B0
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Advanced Exercise #4 Set up a multi-level calibrated method for a sequence

Task 6. Select a new report template for a report

Steps Detailed Instructions

1 Select a report template for a single a On the selection tree, select Reporting.
standard injection report b On the Reporting table, select the Standard single injection report type.
Click the Select Template... button.
The Select Report Template dialog box appears.
d On the Select Report Template dialog box, select the template for the
Standard Single Injection Detailed report.

e Click OK.
B Select Report Template E
Templates k.

= Individual Report Templates Cancel
; & devices hirl [Instrumert)

Help

LLI

- iR short htm [Standard Slngle In|ec:t|0n Eondensed Heport]

{1 Methods
2 Select these report types to print: a Double-click the Print cell for the Multi-Injection Summary Group report to

Sample single injection change Yes to No.
Standard single injection b Repeat step a for the Calibration Standards Group report to change Yes to No.
Sequence

Print Report Type Report Template

Yes  Sample single injection exerbinjdec.html

Yes  Standard single injection sin_d.html

Yes  MultiFinjection Summary Group Smp_short bt
Mo Calibration Standards Group | Cal_shorthtm
Mo QC Sample Group QC_short. htm

Sample Group

Mo Custom Sample Groups Surr_short, htm

Yes  Sequence Seq_shorthtm

Mo Customer Report 1 Composite_1.xml
Mo Customer Report 2 Composite_2.xml
Mo Customer Report 3 Composite_3.xml
Select Template... | Edit Template... |

3 Save the method. a On the Standard toolbar, click [, and enter your reasons for changes and

electronic signature, if required.
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Advanced Exercise #4 Set up a multi-level calibrated method for a sequence
Task 6. Select a new report template for a report
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide

Advanced Exercise #5
Set up a method for a sequence to
quantify impurities

This exercise contains a series of tasks to learn how to:

* Include custom, noise and system suitability calculations in
the method for a sequence

¢ Include bracketed calibration and ISTD quantitation in the
method

* Set up a custom calculation to average the percent impurities
of all the samples in the sequence over multiple injections

e Set limits for custom and system suitability calculations

* Set up a sequence template for bracketing, multiple
injections and a blank run for a S/N calculation

* Set up the Result View layout to see the custom and system
suitability calculations.

* Edit a report template for a sample group report to include
the custom and system suitability calculations

You can use this method with “Advanced Exercise #5a Run a
sequence to quantify impurities” on page 61 and “Advanced
Exercise #5b Use a different method to reprocess” on page 67.

In the tasks in this exercise, try the steps on the left without the
detailed instructions. If you need more help, follow the detailed
instructions on the right.

Before you start

Read “Setting Up Methods” on page 71 to set up methods.
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Task 1. Copy a method to create a new method template for a sequence

Steps

Detailed Instructions

1 Copy the method to create a new
template.
Copy either exerdiii or defexer4iii.
You can use the original method
from Exercise 4 or the modified
method from Exercise 4b.
Name the method template,
exerbiii, where iii are your initials.
Note that the Method Wizard panels

contain the method selections in
Exercise 4.

2 Include the capability to set up
custom calculations and system
suitability calculations

a Select File>New>Method or click L] and select Method.

The Method Wizard appears.

b Click the Browse button, and select exer4iii or defexerdiii.
¢ Enter exerbiii in the New Method Name box.

New Method

|

Mew Method name :

IexerSdec

Do you want to select an existing Method as
a template for the new Method 7

exerddec

‘what kind of Method do pou
want to create 7

Click Next until you reach the Data Analysis panel.

Browse ... |

= Single Sample

* Sequence

On the Data Analysis panel, mark the Custom Calculations check box.
Mark the Include Noise Calculations check box.

Note that when you mark the Include Noise Calculations check box, the
Include System Suitability check box appears marked and dimmed.

Method Wizard

Data Analysis

Do you want ta include
Compound |dentification’?

Do you want ta include
Calibration and Quantification’?

Do you want to uze Custom
Calculations?

Do you want ta include Moise
Calculation?

[ e want tenelide Spstem
Suitabiity Calculationse

¢ Click Next to scroll to the Compound Table panel.

K E

IV Compound Identification

¥ Calibration and
Quantification

¥ Custom Caloulations

W Include Moise
Calculations

¥ | [rclivde Gpsten
Statiity
[5Gl it
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Steps

Detailed Instructions

3 Select a Compound Table option.

Even though you are changing the
mode of calibration to Bracketing, you
can keep the calibration setup from
Exercise 4.

4 Select Calibration options.

Select Bracketing and keep all other
options the same.

Compound Table

|

Calibration

|

a 0Onthe Compound Table panel, Select Keep Compound Calibration from

Method template.

How do you want the calibration to be set up?

" Set up a new Compound Calibration,

' Set up a new Manual Calibration.

& Keep Compound Calibration from Method template.

b Click Next until you reach the Calibration panel.

a On the Calibration panel, select Bracketing.

Method Wizard (2]:

Do the standards in your
method always contain Fized
Amounts or Y ariable Amounts?

Does this method use more than
one concentration level of the
calibrated compound|z]?

what kind of Calibration do
you need?

Wwhat kind of Calibration
Procedure do you need?

b Click Next to scroll to the Quantitation panel.

& Wariable Amourt
7 Fived Amaurt

IV Multi Level |2

" Overall Calibration
1 Si fate Calibration

' Instrument 5 pecific
Calibration

&' Sequence Specific
Calibration
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Steps

Detailed Instructions

5 Select Quantitation options

6 Review your new method template.

The new method contains the same
data analysis and sequence template
information as in the method for
Exercise 4.

a On the Quantitation panel, mark the Limit checks check box.

b Select ISTD.

Method Wizard

Quantitation H

(2]

Do you want ta include limit checks v
on the calculated results ? i

“which Calibration Mode do you  ESTD
want to use in your Method & I5TD

¢ Click Next to scroll to the New Method Review panel.

a 0Onthe New Method Review panel, review the Method Wizard Settings.
b Click the Finish button to save your new method.
¢ Save the changes to the database, with a reason, if necessary.
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Task 2. Edit quantitation for an internal standard

Steps

Detailed Instructions

1 Setup the ISTD quantitation.
Set biphenyl as the internal standard

a

Expand the method that you just created, and expand the Data Analysis
folder.

and use it for the quantitation of b On the selection tree, select Quantitation Setup.
dimethylphthalate. ¢ Click the Calibrated Compounds tab.
d On the calibration table, select biphenyl.
e Under Internal Standard, mark Set this Compound as the ISTD.
f Select dimethylphthalate.
g Under Internal Standard, mark Use ISTD compound.
h Click the down arrow, and select biphenyl from the list.
Calibrated Compounds I Uncalibrated Compounds I Unidentified Peaks I
Compound Hame | Expected Time | Comp d Group ISTD ISTD Name Com
dimethylphthalate 0.9345 biphenyl
bipheryl 1.G302 5TD
Compound Mame dimethylphthalate
Internal Standard Compound Group
INone 'l Mew..
I | St this Eompound as e ST
¥ UselSTD compound Ibiphenyl 'l Compound Infa
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Task 3. Set up a custom calculation to average the percent impurities of

all the samples in a sequence

Steps Detailed Instructions

1 Set up to calculate the percent of a Inthe selection tree, select Custom Calculations under Data Analysis.
impurity in each single injection. b Click the Single Injection tab, if necessary.
The isocratic standard is a well-defined ¢ Add a column that contains the Amount variable for all compounds/peaks.
sample with known compounds. To help Right-click the table, and select Add Column.
you learn how to set up a custom In the Existing Column sheet, expand Compounds and select Amount.
calculatiqn, pretenq that the . Click Apply.
composition of the isocratic standard is 4 Add a column for the percent specified impurity calculation.
the following: Click the Add a New Custom Calculation Column tab.
Main compound - dimethylphthalate Enter the Variable ID for the specified impurity as anything you want, e.g.
Specified impurity - diethylphthalate PercentSpecifiedimpurity (no spaces).
ISTD - biphenyl Enter the Display Name, e.g., Percent Specified Impurity.
Unspecified impurity - unknown peak Select the Level as Single Inj. Variables, then click Apply.

e Add a column for the percent unspecified impurity calculation.
Enter the Variable 1D, the Display Name, and select the Level as Single Inj.

You can also point and drag the cell Variables, and click OK.

reference to specify the cells in the f Enter the formula for the percent specified impurity calculation into the Single

calculation. Inj. Variables cell.

Enter the syntax =D8 /SUM (D7 : D13) *100, which represents the
amount of diethylphthalate divided by the sum of the amounts of all the peaks
x 100. You can use the f, button to find the SUM function, or you can type

SUM.

g Enter the formula for the percent unspecified impurity calculation into the
Single Inj. Variables cell. (Use same syntax as for the specified impurity.)

1 = =

| Amaont Percent Percent
Specified  |Unspecified

2 Impurity Impuirity

Eal

4 |Single Injection

5| Single Inj. Wariables

& |- [Identified Compounds

17 | dimethylphthalate

|2 | diethylphthalate

9 biphenyl

10 - [Mot Identified Peaks

11 Unknown 1

I

13 Unknown n
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Steps Detailed Instructions

2 Set up to calculate the average percenta On the Custom Calculations workspace, click the Multi-injection tab.
of impurity for all injections of a b Add a column for percent specified impurity.
sample. Right-click the table, and select Add Column.

On the Existing Column sheet, expand User Defined, and select Percent
Specified Impurity.
Click Apply.

¢ Add a column for the percent unspecified impurity.
Select Percent Unspecified Impurity.
Click Apply.

d Add a column for the average of the percent specified impurity for all injections.
Click the Add a New Custom Calculation Column tab.
Enter the Variable ID as anything you want, e.g., AvgPercentSpecified.
Enter the Display Name as a variant of the ID, e.g., Avg Percent Specified.
Enter the Level as Multiple Inj. Variables, and click Apply.

e Add a column for the average of the percent unspecified impurity for all

injections of a sample.

Enter the Variable 1D, Display Name and Level as Multiple Inj. Variables.
Click OK.

f Enter the formula for the average of the percent specified impurity into the

Multiple Inj. Variable cell.

Enter the syntax =AVERAGE(D6:D8), which represents the average of the
percent impurity calculation for each sample or all injections. You can use the
f, button to access the AVERAGE function, or you can type AVERAGE.

g Enter the formula for the average of the percent unspecified impurity.

Do this for both the specified and
unspecified impurity.

4lB| c D E F G
= =
Percent Percent  |Awg Percent| &g Percent
Specified | Unspecified | Specified | Unspecified
Impurity Impurity

[x)

H

Multi-Injection Sumrmary

- [Multiple Inj. Wariable
Single Inj. #1

Single Inj. #n
- [dimethylphthalate
Single Inj. #1

|D o o:;|~.a|o\ Ln| &= L.J|

Single Inj. #n

b3
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Steps Detailed Instructions

3 Setup to calculate the average percenta Click the Sample Group tab in the Custom Calculations workspace.

of impurity for all samples. b Add a column for average percent specified impurity.
Do this for both the specified and Right-click the table, and select Add Column.
Expand User Defined, and select Avg Percent Specified.

unspecified impurity.
Click Apply.

¢ Add a column for the average percent unspecified impurity.
On the Existing Column sheet, expand User Defined, and select Avg Percent
Unspecified.
Click Apply.

d Add a column for the average of the percent specified impurity for all samples.
Click the Add a New Custom Calculation Column tab.
Enter the Variable ID as anything you want, e.g., AvgPercentSAllSamples.
Enter the Display Name as a variant of the ID, e.g., Avg % S All Samples.
Enter the Level as Sample Group Variables, and click Apply.

e Add a column for the average of the percent unspecified impurity for all

samples, e.g., AvgPercentUAllSamples.

Enter the Variable 1D, Display Name and Level as Sample Group Variables.
Click OK.

f Enter the formula for the average of the percent specified impurity.
Enter the syntax =AVERAGE(F6:F8), which represents the average of the
percent impurity calculation for all samples. You can use the f, button to
access the AVERAGE function, or you can type AVERAGE.

g Enter the formula for the average of the percent unspecified impurity for all

samples.

4[E] c D E F G
1 = =
| Ay Percent| Avy Percent | Avg % S Al Awvg % U Al

Specified | Unspecified | Samples Samples

2
EaB
4 |Samples i
5 |- [Sample Group Vatiahl =AVERAGE
& Sample #1 (EEES)
7]
g Sarmple #n
g |- [dimethylphthalate
|10 | Sample #1
11 ..
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Task 4. Set up limits for the custom and system suitability calculations

Steps Detailed Instructions
1 Set up limits for system suitability a Select Limits under Data Analysis.
calculations b Make sure the Single Injection sheet appears.
If tailing factor > than 1.7, then say ¢ Right-click the Limits table, and select Insert New Limit.
Not Passed - all samples andonly ~ d Expand the Peak folder, and select TailingFactor.
dimethylphthalate e From the Condition list, select >, and for Value, enter 1.7.
If USP resolution < than 1.5, then f From the Apply to list, select dimethylphthalate, and click OK.
say Not Passed - all samplesand all g Repeat steps ¢ and d for Peak resolution USP.
compounds h From the Condition list, select <, and for Value, enter 1.5.
If signal to noise is less than 5, then i Click OK.
say Not Passed. i Repeat steps c and d for SignalToNoise.
¢ From the Condition list, select <, and for Value, enter 5.
I Click OK.

Limit Optians for:

Single Iniel:linn] Multi Injection I Summary Groups ]

Variable |D

Header

Units

Condition

Value

SignalToMoize

SignalToMoize

<

TailingFactar

TailingFactar

>

USP_Resolution

Peak resolution USP

e

2 Set up limits for both the average of a Click the Summary Groups tab.

the specified impurity and the
average of the unspecified impurity
for all samples.
If specified impurity > 10%, not
passed
If unspecified impurity > 5%, not
passed

Hint: The tab Summary Groups let you
set limits for all the variables and
calculations associated with
sample-type groups, such as sample
group, calibration standard group,
custom sample group and QC group.

(1}

e = o o

Right-click the table, and select Insert New Limit.

In the Insert New Limit dialog box, expand the Single Values folder and select
Avg % S All Samples.

From the Data Set list, select Sample.

From the Condition list, select >.

Enter a value of 10, and click OK.

Repeat steps b-f for the Avg % U All Samples and a value of 5.

Lirnit Options for:

Single Injection ] ulti [ njgction ]Summaw Gluups]

Variable ID

Header

Units

Data Set

Apply To

AvgPeicenttals amples

Eve % F AN Gamples

Al

Selected Variable 1D

AvgPercentUANS amples

Avig % U All Samples

Al

Selected Variable ID
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Task b. Edit the sequence template for bracketing and multiple injections

Steps

Detailed Instructions

1 Setup the brackets
Quantify the first set of samples
with the average RFs of the first and
second sets of standards.
Quantify the second set of samples
with the average RFs of the second
and third set of standards.

2 Enter a blank sample in the first row
and enter two injections for each
sample.

Select Sequence Template in the selection tree.

Double-click the Bracketing cell for Call in row 1, and double-click Open.
Double-click the Bracketing cell for Cal1 in row 5, and double-click Open.
Double-click the Bracketing cell for Cal2 in row 6, and double-click Close.
Double-click the Bracketing cell for Cal2 in row 10, and double-click Close.

o220 T o

a Selectrow 1, and click the Insert button. (Use tooltip.)

b Enter NoiseBlank for the Sample Name, and select Blank Run for the Sample
Type.

¢ Enter a different Vial#, and click Apply.

d Enter 2 for the Injections # for each sample in the sequence.

o P Injection
Sample Name Sample Type L(I::IIl.ﬂ Bracketing CuﬂnGwrluizmple V;al I“JB[:"]"S Volume i:::sl:(
MoiseBlank Blank Run 4
2 |eait Calibration 2 1
3 cal2 Calibration 2 Mone: 3 1 az method |0
4 sample1_2 Sample 2 2 as method |0
5 sample1_4 Sample 9 2 a5 method |0
6 call Calibration 1 Open 2 1 as method |0
7 cal2 Calibration 2 Close 3 1 as method |0
8 |sample1_2 Sample 5 2 as method |0
9 sample1_4 Sample 9 2 az method |0
10 call Calibration 1 e 2 1 as method |0
11 calz Calibration 2 Close 3 1 a5 method |0
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Task 6. Set up the Result View layout to see custom and system suitability
calculations

Steps Detailed Instructions

On the selection tree, expand the Data Review Layout folder.

Select Single Injection in the selection tree.

Select Summary Table in the workspace.

Select Percent Specified Impurity from the Available Items list, and click > to
move it to the Display Items list.

e Repeat step d for Percent Unspecified Impurity, and click Apply.

1 Set up to view the percent specified a
impurity and the percent unspecified b
impurity. c

d

Sin_g\e Injection Summary
i Results Table

tSummary T able:

Luyailable Iterns

Display [tems

Noise Calculation Start Time _I

Guantitation Methad [ESTDAS
Guartitation Type [AreasHeigh
Rel AT Reference Time

-

—

Bl

“

Percent Specified [mpurity Number of iterns per Line

Percent Unspecified Impurity

Sample Amaount . =
| N

2 Setup to view the tailing factor, USP a Select the Results Table.

resolution and the S/N for each
compound.

b Select Tailing Factor from the Available Items list, and click > to move it to
the Display Items list.
¢ Repeat step b for Peak resolution USP and SignalToNoise, and click Apply.

Single Injection Summany Available Columns

Results Table

Display Columns

Summary T able Signal Diift - Peak To Peak Moise :I Fixed Columns
Signal Short Description > | Peak width B0% 2
Signal ‘Wander TailingF actar

Peak resolution USP
SighalToMoize

Aol 2

L]z} | Wovir |

[« |

In the selection tree, select Multiple Injection.

Select the Summary Table in the workspace.

Select Avg Percent Specified from the Available Items list, and click > to
move it to the Display Items list.

d Repeat step b for Avg Percent Unspecified, and click Apply.

3 Setup to view the average of the a
specified impurity and the average of b
the unspecified impurity for each c
sample.

Mu\_li—\ njection Surmmary

- Results Tabie Available ltems

Display ltems

fvg Percent Specified

HIniection Yolume Mumber of items per Line

Summary Table gzﬁs:z ﬁr;wr?;nl _>| fvg Percent Unspecified h_
Sample Pogition _<|
ETR— o la g 2
L]z} | (ke ]
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Steps Detailed Instructions

4 Set up to view the average of the a Select Samples in the selection tree.
percent specified and unspecified b Select Summary Table in the workspace.
impurities in all the samples and ¢ Select Avg % S All Samples from the Available Items list, and click > to move
their limit checks. it to the Display Items list.

d Repeat step c for Avg % U All Samples, Avg % S All Samples Limit Check and
Avg % U All Samples Limit Check.

e Click Apply.
Sample Group " .
o Results Table Available ltems Display Iterms
-~ Summary Table Awg % 5 Al Samples ﬁ_umk.:el of items per
> | Ava % 5 Al Samples Limit Check | S8
ten % U A Samples I
< | g % AN S amples Limit Check
4 | _>| 4 | | LI
(e} | Doy
Spgll
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Task 7. Edit a report template for the sample group

Steps

Detailed Instructions

1 Edit a report template for a sample
single injection report.

Edit the inj.html report.
Add a column for USP resolution
and Signal to Noise to the existing
compounds table under the
chromatogram.
Save the template as exerbinjiii,
where Jjii is your initials.

On the selection tree, select Reporting.

Select the Sample single injection report type, and click Edit Template....
Double-click Individual Report Templates, and double-click inj.html.

Place the cursor in the last column of the compounds table located beneath
the chromatogram.

e Right-click the table, and select Table Properties.

The Compound Table Properties dialog box appears.

0 oo

f Inthe Select Column Fields list, mark the Peak resolution USP and

SignalToNoise check boxes, and click OK.

¥ Compounds Table Properties

~ Select Column Fi ~ Lapout
Ok
E : =t = Table ste: [
oo Ime: atar n
-] # Level Start ICIESSIC jv Caned
E: ?:::IE:dStan g[l)\ngTnl' = Background...
O # LevelEnd I slault :[ -
el
~-C] # Baseline End Cell Dividing Fules: il
[ % Peak Type and Separation Code
[ % Calbration Peak Type IA" j'
~- 1% Identify Peak Methad Border Size
- & &eaHeight Duantitation - —|
-1 % Calib Curve type h =
O % Calib Curve crigin Cell Padding:
-] # Coefficient a IW_—A
O # Cosflicient b =
-] # Coefficient o B SEEE
-] # Coefficient d B = —|
-0 % Peak Processing Motes =l
o[ # Peak width 5%
O # Peak Widh 50 T
-] # Peak Tangent Width
O # kFime ¥ Specify width
-~ # Plate number EP/DAB l—
-] # Plate number ISP 100
-] # Plate number BP & InPement
-] # Plate number JP -
[ # Peak resolution EFAIP/BF/DAR € In Pizels
- [l # Peak resolution ISP
# TaiingFactor
~-C]# Symmetry |
[ # SignalToHise i
The compound table in the resulting template looks like this:
. - Peak
Retent_lon Compound Amount Response h’alllng resolution | SignalToNoise
Time Name Factor Factor USPp
RS A | R A H.ODDD | AR i Hi A i R
g Select File > Save As, enter exerbinjiii, and click OK.
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Steps Detailed Instructions

2 Editthe sample group detailed report
template (sus_d.html).

Exit the Report Template Editor.

Select the Sample Group report type, and click Edit Template....

Insert an html table under the Double-click Individual Report Templates, and double-click sus_d.html.
Sample group variables table. Insert a line below the Sample group variables table, and click the Insert
Enter the text for the Avg. % S HTML table button.

20 T o

Impurity All Samples and Avg% U e Inthe Insert Table dialog box, select the Classic Table Style and click OK.
Impurity All Samples. f Click the Fields tab and expand the Sample Group folder.

Enter the placeholder for the values g Expand the Sample Group Variables Results folder.

for the % impurities. h Place the cursor into the first cell of the HMTL table, press the Alt key and
Under the Sample Group Limits double-click Avg % S All Samples.

table, enter the Limit check i Place the cursor into the second cell in the first row and double-click Avg % S
information for the sample group. All Samples.

Save the template as exerbsgiii,
where jii are your initials.

Repeat steps h and i for Avg % U All Samples, using the second row.
Place the cursor below the Sample group limit results table.

Press the Ctrl key and double-click Avg % S All Samples Limit Check.
Do the same for Avg % U All Samples Limit Check.

Select File > Save As, enter exerbsgiii and click Save.

53_7‘_'

After you finish, the template displays

Sample group (detailed
as the Sample group template Ple group ( )

—p Sequence name SO ORI RO RO,
Sequence Start sys_Date, sys_Time
Sequence End sys_Date. sys_Time
Method (rev): OOCOIOOCOCOOCOOK | ##t )

Nurnber of unidentified peaks: ##

Sample group variables
# |Sample name Amount Position| Inj. vol.
| SOCOOOCOCOCOCOCOCOC | ## . DDDD | XCOCOCO | 3 DD

Avg 26 S All Samples: #.0D
Avg % U All Samples: #4.0D

Sample group limit results

Limit| . .
# |Sample name Compound {Compound) Limit {(Sample}
SOCOCRCOCOTOCOCTK. | SOOI | 3OCOCOCOK | DCOOOCOOCX
#it

Avg 2% S All Samples Limit Check: >XCCOOOOOOK

Avg % U All Samples Limit Check: XCCOCOEO0K
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities

Task 8. Select report templates and report types

Steps

Detailed Instructions

1 Select report templates for report
types.
Use exerbinjiii for the Sample single
injection report.
Use exerbsgiii for the Sample group
report.

2 Select these report types to print.
Sample single injection
Standard single injection
Multi-injection summary
Sample group
Sequence

3 Save the method

Exit the Cerity Report Template Editor.

Select the Sample single injection report type and click Select Template....
Select exerbinjiii and click OK.

Select the Sample group report type and click Select Template....

Select exerbsgiii and click OK.

o220 T o

a Double-click the Print cell for the Multi-Injection Summary Group report to
change No to Yes.
b Repeat instruction (a) for the Sample Group report to change Yes to No.

Print Report Type Report Template
Yes  Sample single injection exerbinjdec.html
Yes  Standard single injection sin_d.html

Yes  MultiFinjection Summary Group Smp_short bt
Mo Calibration Standards Group | Cal_shorthtm
IO QC Sample Group CC_shorthtrm
Sa up htrnl
Mo Custom Sample Groups Surr_short htrn

Yes  Sequence Seq_shorthtm
Mo Customer Report 1 Composite_1.xml
Mo Customer Report 2 Composite_2.xml
Mo Customer Report 3 Composite_3.xml
Select Template... | Edit Template... |

On the Standard toolbar, click [[ig]. and enter your reasons for changes and
electronic signature, if necessary
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Advanced Exercise #5 Set up a method for a sequence to quantify impurities
Task 8. Select report templates and report types
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